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What is VBE_Extras 
 
VBE_Extras is a COM AddIn for the Visual Basic Editor (VBE) within 32- and 64-bit versions of Excel, Word, Outlook, PowerPoint 
and Access (the 'host applications') - one installation works for all host applications. It works only on Windows 7 (or newer) and 
requires .NET Framework 4.8. 
 
Once VBE_Extras is installed (see Installation), start one of the relevant host applications and open the VBE (Alt + F11, or using 
the 'Visual Basic' button in the 'Developer' tab of the ribbon). The VBE_Extras Functions are then available to you via a number 
of keyboard shortcuts, a Toolbar and via various menu items which are added: 

• To the main VBE menu 

• To the code window context menu 

• To the Immediate window context menu 

• To the Project window context menu 

• To the UserForm Control context menu 
 
For users of Excel, VBE_Extras is supported by the VBE_Extras Helper AddIn which can be downloaded and installed separately.  
 

Why use VBE_Extras 
 
To save you time and help you write better code. 
 
VBE_Extras provides a number of Functions that assist developers to create and edit VBA code and the number and scope of 
those functions are continually expanding over time. However, it is also the intent not to directly duplicate functions with those 



 
 
already available in certain other tools that also extend the capabilities of the VBE, notably the excellent MZ-Tools which also 
provides a wide range of VBE functions and enhancements (note that I have no link or association with MZ-Tools or its author). 
 
And, unlike some other VBE AddIns, VBE_Extras will not slow down the process of creating code with regular lengthy "code 
parsing" exercises which block you from interacting with the VBE. Rather VBE_Extras will sit quietly in the background taking up 
zero resources (well, close to it … we have to log the cursor position and Modules being shown/edited for the Show History and 
Project Picker / Module Picker functions) until you ask it to do something. 
 

Installation 
 
VBE_Extras is installed on a per-user basis and does not require admin rights to install. 
 
To download, click the 'download' link on The VBA Help website at https://www.thevbahelp.com/vbe-extras-download. 
 
To install: 

• Ensure you are the only user logged on to the device 

• Close all MS Office applications (and any other applications on your device that can host VBA code) 

• Unzip the downloaded file and then double-click on the VBE_Extras_Setup.exe file 

• Follow the instructions in the installation wizard including accepting the licence 
 
If you experience any problems while installing, please see Appendix 1 – Installation troubleshooting 
 

Uninstallation 
 
If you just want to temporarily suspend VBE_Extras, in the VBE main menu select Add-Ins > Add-In Manager > VBE_Extras then: 

• Remove the tick (check) from 'Loaded/Unloaded' if you want to suspend VBE_Extras for this one session, it will load 
automatically in future 

• Remove the tick (check) from 'Load in Startup' if you want to suspend VBE_Extras from automatically loading in future 
 
If you want to permanently uninstall VBE_Extras then: 

• Go to Control Panel > Programs and Features, or 

• Go to Settings > Apps 

• Then select VBE_Extras and then click the Uninstall button … you can choose to not delete your settings if you want them to 
be available in the future 

 

Terminology 
 
In this document: 
 

This … … means this 

Declaration A declaration of any type e.g. variables (declared with the Dim keyword), Procedures (declared 
with the Sub or Function keyword), Properties (declared with the Property Get/Let/Set 
keywords), Modules (no specific declaration keyword, visible in the Project window), Enums 
(declared with the Enum keyword) etc. 

Field A Module-level variable 

Host / host application The application that is currently hosting the VBE (Excel, Word, Outlook, PowerPoint or Access) 

Project  A specific VBA Project 

Project reference  Either: 

• A reference between two VBA Projects which can be: 
o To a "child" Project (the active Project has a reference to the "child" Project)  
o From a "parent" Project (the "parent" Project has a reference to the active Project) 
o An "indirect" Project reference (the active Project and another Project both have 

"child" references to the same 3rd Project … the "indirect" reference is to other 
Project having a reference to the same "child" Project) 

• A reference from the active Project to a Type Library 

Reference Any reference to (or 'usage of') a declaration … a reference can be a: 

https://www.thevbahelp.com/vbe-extras-download


 
 

• "qualified reference" – the reference 'target' is preceded by the Module and/or Project name 
(separated by a '.') where relevant 

• "unqualified reference" – VBA allows you to refer to a member of another Module or Project 
without using the name of the Module and/or Project preceding it (delimited by a '.') … 
where a reference omits the Module and/or Project name then this is an 'unqualified 
reference' 

type (lowercase 't') The value type assigned to a variable, Function or other declaration (i.e. can be defined by the 
word(s) following the 'As' keyword or can use one of the Type hint characters or can be defined 
by one of the DefType statements) 

Type ('uppercase 'T') A 'user-defined Type' (UDT) 

Type Library (or TypeLib) A file that contains one or more 'types'. Types include Classes, Modules and Enumerations, 
Variables, Functions etc. Typically, you add a Project reference to a Type Library to enhance the 
functionality of VBA / the VBE … for example, you can add a Project reference to the 'Microsoft 
Scripting Runtime' Type Library to use the FileSystemObject and Dictionary Classes. To read more 
about Type Library's, see my Adding / updating "Project References" in the VBE blog post. 

UI The user interface i.e. of the host application 

 

Language 
 
As a solo developer who speaks only English, I'm afraid that I have developed VBE_Extras to display messages and accept inputs 
in the English language only. However, other than the few exceptions specified throughout this document, all functionality will 
work no matter which language you use as your Office 'display' or 'authoring' language. 
 

What's new in VBE_Extras 
 
See Appendix 2 – Update history 
 

Limitations / exclusions 
 

Finding references in code comments and string literals 
 
It is the aim of VBE_Extras to accurately find every reference to a declaration in the code of a Project … no false positives (where 
the same name is used in the same scope) and no false negatives (missing references). 
 
However, the same is just not possible in code comments and string literals. VBE_Extras just 'does its best'. There are a number 
of reasons why finding every reference in in code comments and string literals is not possible: 

• Code comments and string literals can 'refer to' declarations from a scope in which that declaration would not normally be 
accessible, for example you can have code comments in one Procedure that refers to a variable 'Dimmed' in another 
Procedure … this is, of course, entirely 'legal' as far as VBA is concerned, but does mean that the link from that code 
comment to the variable Dimmed in another Procedure cannot be established 

• Code comments and string literals can be used 'unqualified' (see Terminology) and without the usual 'context' that using the 
same name in code provides 

• It is not possible to disambiguate between multiple declarations with the same name when used in code comments or 
string literals 

 

Keywords used for Type element names 
 
VBE_Extras cannot distinguish these from normal uses of the reserved word. Still, why would you want to call a Type element 
'For' or 'Next' … you want to write code that is clear, right! 
 

Late-bound references 
 

https://www.thevbahelp.com/post/adding-updating-project-references-in-the-vbe


 
 
To resolve references to a specific declaration, VBE_Extras requires declarations to be explicit about the value type that a 
variable holds / Function returns etc. If a variable is defined 'As Object' or 'As Variant' (late binding) as opposed to 'As SomeClass' 
(early binding) then VBE_Extras cannot determine the specific value type that you actually intended … in just the same way that 
the VBE itself cannot determine the specific value type. 
 
Wherever possible, you should declare and return explicit value types (i.e. use early binding) so that VBE_Extras can help you 
work with your code. 
 
Alternatively, consider using Special binding. 
 

Using VBE_Extras in Access 
 
Limitations / exclusions 
 
When using VBE_Extras in Access, the following limitations / exclusions apply: 
 
1. When parsing code (working with references, including identifying Orphan declarations), the following are excluded: 

a. Access Macros (including those referenced from Form, Report and Control events and those that reference to 
Functions or other VBA members) 

b. Expressions in Form, Report and Control events 
… so, for example, if you get References for code at cursor for a VBA Function that is referenced by an Access 
Macro, the list of references displayed will not include the reference in the Access Macro. 

2. Go to declaration for code at cursor for a Control will only go to the Form/Report and will not highlight the specific Control 
3. When working with an AddIn (when it is loaded as an AddIn e.g. via Database Tools > Add-ins), VBE_Extras will not identify 

Controls in a Form or Report and so cannot 'go to' them, rename them and will not correctly identify event handlers as 
being related to them. This functionality will work correctly when the AddIn is 'loaded directly' (e.g. via File > Open). 

4. When working with a VBA Project that is open because it is referenced by a 'parent' Project (and so it is not the Project 
associated with the Database that is loaded in the Access UI), then: 

a. The same restrictions apply as for an AddIn (see point 3) 
b. That Project cannot be saved (and so updates made by VBE_Extra's refactoring functions cannot be saved) … 

see Referenced VBA Projects (including the 'Access workaround') for more info 
 
Other 
 
When renaming a Project or Module, Access allows certain characters to be included in the name that are 'not recommended' 
by Microsoft (see https://learn.microsoft.com/en-us/office/troubleshoot/access/error-using-special-characters). VBE_Extras will 
warn you when one of these characters is used in a proposed new name. 
 

Using VBE_Extras with files stored on OneDrive 
 
VBE_Extras works well with files (Workbook, Documents, Databases etc) stored on OneDrive … unless you have a non-standard 
OneDrive setup. 
 
When carrying out many functions, VBE_Extras needs to know the file path of the file it is working on (for example, for Version 
Control when using 'Project folder' or 'Project sub-folder' as the export / import folder). To get this location, VBE_Extras uses the 
methods and properties supplied by the host application. 
 
However, as has been detailed in various https://stackoverflow.com/ questions and answers, when a file is saved on OneDrive, 
the host application may return a file path ("C:\ …") or may return a web link ("https://..."). When a web link is returned, 
VBE_Extras can parse this into a file path so long as you have a standard OneDrive setup. An example of a non-standard 
OneDrive setup include having multiple OneDrive accounts on the same device where the 'personal' folder for one account is 
inside the 'personal' folder for the other account. 
 
If you have a non-standard setup and the file path could not be parsed then you may see messages advising you of this. The 
solution, if you want to continue using VBE_Extras, is either to fix your OneDrive setup (which might not be simple … once it has 
installed on your device) or to move the file to a local (i.e. non-OneDrive) folder. 
 

https://learn.microsoft.com/en-us/office/troubleshoot/access/error-using-special-characters
https://stackoverflow.com/


 
 

Code in the Immediate window 
 
The VBE_Extras functions work with code in the code pane (i.e. the main window in which you edit code) and do not work with 
code in the Immediate (or any other) windows. 
 

Inclusions 
 

Referenced VBA Projects 
 
VBE_Extras is 'multi-Project'. This means that all functions (except where specified; in host applications that allow it), operate on 
the active Project plus other VBA Projects that are connected to the active Project by a 'Project reference' ('Project reference' 
means a reference from a 'parent' VBA Project to a 'child' VBA Project via the VBE's References dialog: Tools > References). 
 
So, for example, VBE_Extras can: 

• Find declarations in other Projects 

• Find references in other Projects 

• Rename declarations (and all references to that declaration) in other Projects 
 
Some functions are intended to be 'single-Project', these are identified in the menus by use of the 'this Project' text, for 
example: 

• 'Tasks in this Project' 

• 'Previous Lists for this Project' 
 
Note that being multi-Project does not mean that a function always operates on every open VBA Project – VBE_Extras can 
determine: 

• Which Projects the active Project has a reference to (ie 'child' Projects) 

• Which Projects have a reference to the active Project (ie 'parent' Projects) 

• Which Projects also have a reference to a child Project that the active Project also has a reference to (ie 'indirect' Projects) 
… and carries out functions on those Projects only and, even then, does so only if appropriate (eg if you ask VBE_Extras to 
rename a Public variable in a standard Module that does not have 'Option Private Module' then it will look for references in the 
active Project and all 'parent' Projects but if you ask VBE_Extras to rename a Private variable then it will look for references only 
in the active Project). 
 
Obviously, VBE_Extras can only operate on open Projects. The host application will always automatically open any 'child' 
Projects (so they will always be updated) but will not automatically open any 'parent' or 'indirect' Projects (so they will not 
always be updated … you need to open them before using any 'refactoring' functions). If the active Project has 'broken' 
references to other Projects then those other Projects cannot be operated on. 
 
Additionally, VBE_Extras can only operate on unlocked Projects – if a Project is locked (Tools > Project Properties > Protection > 
Lock Project for viewing) then the VBE itself prevents VBE_Extras from reading or updating code in those Projects. 
 
Note that not all supported host applications work in the same way when it comes to references to other Projects: 

• Excel and Word allow references to other Projects and code in those Projects can be read, updated and saved 

• Access allows references to other Projects and allows code in those Projects to be updated – but the VBE itself (when 
hosted in Access) does not those other Projects (i.e. Projects other than the one that is associated with the Database that is 
open in the Access UI) to be saved … note that both the 'Save' icon and 'Save' menu item in the VBE's menu will be disabled 
when the Project that is active in the VBE is an 'other' Project … see the 'Access workaround', below 

• PowerPoint allows references only to AddIn Projects and the code in AddIns is not available to be read or updated (this is 
not a restriction of VBE_Extras, rather it is a restriction imposed by PowerPoint itself) 

• Outlook does not allow references to other Projects 
 
In the Settings you can choose to switch off 'multi-Project' so that VBE_Extras ignores all referenced Projects. You can also 
choose to block individual Projects based on their Project name, file name or full path (none of these are case-sensitive). Code in 
blocked Projects will not be read or updated in the same way that code in locked Projects will not be read or updated. 
 
Access workaround 



 
 
 
When the VBE is hosted by the Access application, the VBE cannot save a 'child' Project, only the active / 'parent' Project can be 
saved. This is a limitation of the VBE itself, not of VBE_Extras. 
 
As such you need to update code in both the active (i.e. 'parent') Project and in a 'child' Project in Access (e.g. if you need to 
rename a declaration that is declared in the child Project but is referenced from the active/parent Project), the workaround is: 
 
1. It should go without saying … but, first, make backup copies of all Projects to be updated 
2. With the parent Project as the active Project, use VBE_Extras to rename the declaration/reference 
3. Save the parent Project and close it in the Access UI (meaning that the changes to the parent Project are saved but the 

changes to the child Project are not saved) 
4. If you have multiple parent Projects each using the declaration that is declared in the child Project then update each parent 

Project (points 1 and 2) before continuing to update the child Project 
5. Open the child Project directly in the Access UI then open the VBE and carry out the same rename (i.e. use VBE_Extras to 

rename the same declaration/reference to the same name) 
6. Save the child Project and close it in the Access UI (meaning that the changes to the child Project are now also saved and 

align with those in the parent Project) 
7. Re-open the parent Project and check it compiles correctly (i.e. Debug > Compile) 
 

'Square bracket' references 
 
In VBA, any reference can be enclosed in square brackets whether the square brackets are required or not (they are only 
required where the name of the reference includes normally-invalid characters … otherwise, square brackets are allowed but 
are redundant). 
 
Outside of Access, square brackets are rarely used and typically only for Enum member names that are hidden or include 
normally-invalid characters. However, VBE_Extras can handle square bracket references in Access (for example when Module 
names or Control names include normally-invalid characters) and all other host applications including when you Rename code at 
cursor for Enum members, Modules and Controls. 
 

The bang ("!") operator 
 
If you're not familiar with the bang operator (likely you don't code in Access), the bang operator provides late-bound access to 
the default member of an object, by passing the literal name following the bang operator as a String argument to that default 
member. 
 
VBE_Extras can handle the bang operator. However, as 'code' following (i.e. to the right of) the bang operator is late-bound 
(being passed as a String to the default member of the object on the left of the bang operator) then references are identified as 
Strings (not code) … because they are (Strings, that is). In the same way that the VBE itself cannot compile-time check the String 
following the bang, VBE_Extras cannot parse it as code. 
 
If you want your code to be clear and increase its maintainability, avoid the bang! 
 

Type hint characters 
 
VBE_Extras can handle type hint characters e.g. a variable defined such as "Dim text$" instead of "Dim text As String" … 
VBE_Extras handles all 7 type hint characters: % for Integer; & for Long; @ for Currency; ! for Single; # for Double; $ for String; ^ 
for LongLong (on 64 bit hosts). 
 
While VBE_Extras handles type hint characters, I don't want to encourage their use … they're from the 1980s and should stay 
there. 
 

DefType statements 
 
DefType statements are parsed, determining the value type of variables, Functions, Property Gets etc for the relevant letter / 
letter groups. Note that malformed DefType statements (i.e. that will not compile) are ignored. 



 
 
 
Please don't use DefType statements … every declaration deserves an 'As'. 
 

Declarations with the same name in the same scope 
 
It is possible to do some truly weird stuff in VBA. VBE_Extras can handle the 
(perfectly legal, though shocking unreadable) code to the right. Yes, you can 
(though you shouldn't!) declare: 
 

• A Type, an Event and any one other type of Module-level declaration with 
the same name all in the same Module 

• A Module and a Module-level declaration in the same Module with the 
same name 

• A Sub or a Property Let/Set can have a parameter, variable, static or 
constant within it with the same name 

• A compiler Constant can have the same name as another Module-level 
declaration 

• An Enum and an Enum member can have the same name 

• A Type and a Type element can have the same name 

• A line label can have the same name as another declaration within the 
same Procedure/Property, with the same name as the 
Procedure/Property itself, and with the same name as the Module the 
Procedure/Property is within 

 
While VBA allows it, nobody wants code like "ThisThing"?! But if you do have 
code like this, VBE_Extras can parse the code and get the right references to 
the right declarations. 
 
 
 
 
 
 
 

Shapes 
 
In Excel only, a Sub or Function in a standard or document Module can be assigned to a Shape such that it runs when the Shape 
is clicked … the assignment of a Sub or Function is stored in the Shape's OnAction property. 
 
VBE_Extras treats the OnAction property of a Shape in Excel as a reference to a declaration (i.e. the declaration of the Sub or 
Function). The Shape will be included in the references for that declaration. 
 
The Project must have been saved at least once for Shapes to be correctly recognised. 

Requirements 
 

Option Explicit 
 
Much of the functionality of VBE_Extras (for example finding declarations, references, identifying orphans, renaming) requires 
each variable to be explicitly declared. If VBE_Extras cannot find a declaration, it does not 'assume Variant'. 
 
Good programming practice requires all variables to be explicitly declared. If you use VBE_Extras in a Project that has one or 
more Modules without Option Explicit, you will see warning dialogs (you can change the frequency of the warning in the 
Settings). 
 
You can also consider using the Make 'Option Explicit' function. 



 
 
 

Saved Projects 
 
Much of the functionality of VBE_Extras requires the active Project to have been saved at least once.  
 
Some functionality requires for there to be no more than one open 'never-saved' Project (where 'never-saved' means, for 
example in Excel, where a new workbook has been added and it has never been saved … this does not mean a workbook that 
was re-opened from a file). 
 
And some functionality requires for there to be no open 'never-saved' Projects. 
 
There are various reasons for this, however, it boils down to the fact that VBE_Extras needs to interact with the VBE and the VBE 
is not helpful when it comes to open 'never-saved' Projects: 

• Saving a Project generates a (unique) file name for the Project and a unique identifier is required for many of the functions 
of VBE_Extras … when there is only 1 open never-saved Project then VBE_Extras can use the 'lack of unique identifier' as the 
actual identifier … but this doesn't work when there are 2 or more open never-saved Projects 

• Various properties of the VBE stop responding correctly (they return errors even when read-from, not written-to) when 
there is one or more open never-saved Project(s) and this state of returning errors persists even when the open never-
saved Project(s) are closed or saved (the 'error state' persists until the host application is closed and re-started) … hence the 
workaround is to not to access those properties when there is one or more open never-saved Project(s) – this is the reason 
why, for example, VBE_Extras will not show a UserForm designer when there is one or more open never-saved Project(s) 

 

Conditional compilation 
 
VBE_Extras is 'conditional compilation aware'. Based on any compilation constants (both declared globally in the 'Project 
Properties' dialog and declared in a Module) and compilation directives (#If … #Then … #Else), VBE_Extras will work out which 
lines and, therefore, which variables, Constants, Procedures etc are 'in scope' for compilation or not. 
 
VBE_Extras correctly determines expressions in #If and #ElseIf directives for: 

• Win16 †, Win32, Win64, VBA6, VBA7, Mac – determined appropriately for the device 

• Boolean, numeric, date/time and string operations 

• Computes operators (+, -, *, /, \, Mod, ^ and &), comparators (=, <>, <, >, <=, >= and Like) logicals (Not, And, Or, Xor, Eqv and 
Imp … logical comparisons only, not bitwise comparisons), handles parenthesis, interprets hex &H and oct &O and works 
with VBA functions (for example, Int(), CLng(), Abs())  

 
VBE_Extras does not correctly determine expressions in #If and #ElseIf directives that use: 

• Global Conditional Compilation Arguments unless you have instructed VBE_Extras to read these from the Project Properties 
window using the Conditional Compilation Arguments functions. Note these are read only once when the menu item is 
selected, not every time any VBE_Extras function is called (on the basis that these are not regularly updated, then there is 
not a need to do so). 

 
VBE_Extras supports two modes of behaviour with respect to conditional compilation: 

• Match to conditional compilation directives … in this mode, for example, declarations and references that are not currently 
'in scope' will not be shown in dialogs 

• Do not match to conditional compilation directives … in this mode, for example, declarations and references that are not 
currently 'in scope' will be shown 'greyed-out' in dialogs 

 
The mode being used can be set in the 'Other' tab of the VBE_Extras Settings. 
 
There are two exceptions that ignore the mode: 

• The Rename code at cursor function will display a dialog asking whether you want to rename the 'out of scope' references 
as well as the 'in scope' references 

• The Orphan declarations functions always ignore declarations and references on excluded lines 
 
† Always evaluated to False assuming all VBA code is now developed and run on 32 or 64 bit devices 
 



 
 

Functions 
 

Functions available in the main menu 
 
Many of these functions are also available in other menus, in the Toolbar and by using shortcut keys. 
 
The VBE_Extras main menu uses the 'x' key as its accelerator. If you need to change this, see Appendix 4 – changing the main 
menu's 'x' accelerator key. 
 

Info for code at cursor 
 
Default keyboard shortcut is Alt + F12 
 
The result of this function depends on the position of the cursor at the time. When the cursor is on: 

• A declaration, the result will be information for that declaration, the same as Show declaration for code at cursor 

• A reference, the result will be information for the declaration that reference relates to, again the same as Show declaration 
for code at cursor 

• A Module (document, standard, Class or UserForm) name, the result will be a list of all declarations in that Module 

• White space, the result will be a list of all declarations in the Module that is active in the code window 
 
'Info for code at cursor' is also 'Type Library aware' (and works with Special binding) – for example if you declare the variable fso 
(or whatever name you choose) As Scripting.FileSystemObject and then type fso.CopyFile and place the cursor on CopyFile and 
trigger 'Info for code at cursor' you will see this dialog. 
 

 
Figure 1 - Special binding and 'Info for code at cursor' 

 

References for code at cursor 
 
Default keyboard shortcut is Shift + F12 
 
If the cursor is on a declaration or reference to a declaration, then this will display a dialog with a list of all references of that 
declaration (including the declaration itself). The dialog will allow you to show or hide references in code comments, in strings 
and 'return values' (when a value is being set to the name of a Function or Property Get to be returned to the calling code). The 
dialog will show a column displaying the Project that each reference is within only if the references are contained within 
multiple Projects. 
 
VBE_Extras does not simply find all occurrences of a name, rather if there are multiple Declarations with the same name in the 
same scope then it can apply code-parsing rules to determine which references relate to which declaration. 
 
This function will also find implementations of Interfaces, handlers of Events including for Controls on UserForms (and Reports 
and Forms in Access). 
 
Note that VBE_Extras tests whether Class, Document and UserForm Modules have their VB_PredeclaredId attribute set to True, 
so allowing for 'static' access of members, and tests whether Class, Document and UserForm Modules have their VB_Exposed 



 
 
attribute set to True, so allowing other VBA Projects that reference the Project to 'see' the Module and its members. See also 
Set VB_PredeclaredId attribute and Set 'VB_Exposed' attribute. 
 
You can control whether the declaration (or declarations if conditional compilation is involved) is shown at the top of the list or 
shown in the default order (being Project, Module-type, Module, line, column) in the Settings. 
 
Excel only: Shapes that have an OnAction property that references a Sub or Function in a standard Module will be included in 
the list of references. 
 
Access only: see Using VBE_Extras in Access  
 

Highlight 
 
Default keyboard shortcut is F11 
 
Highlights on-screen matches of declarations/references, words, parenthesis, speech-marks, or 'text' … allowing you to quickly 
identify those matches. 
 

• If the cursor is positioned within a declaration or reference (whether it is an 'insertion point' or expanded to one or more 
characters within the name of the declaration or reference), all of the matching on-screen declaration(s) and reference(s) 
will be highlighted 

• Otherwise, if the cursor is an insertion point within a 'word' (whether a VBA keyword or not) that is not in a string literal or 
in a code comment, all of the on-screen matches of that word will be highlighted 

• Else if the cursor is expanded to one character that is an opening or closing parenthesis or an opening or closing speech-
mark, the matching partner of the parenthesis or speech-mark will be highlighted 

• Otherwise, if the cursor is expanded to one or more characters, all of the on-screen matches of that range of character(s) 
will be highlighted 

 
There are two types of highlighting: 
 

• New-style … temporarily draws a highlighting rectangle over each match (or an underline if the match is a reference that is 
'compiled-out' due to conditional compilation), only works for mono-spaced fonts and when the code pane window is not 
'split' 

• Old-style … temporarily renames the references to a series of fixed characters 
 
In the Settings, you can control: 
 

• Which style is used (new, old or 'try new, fallback to old') and, if old, the colour used 

• Whether references are highlighted even if they are 'compiled-out' and the Conditional compilation mode is set to 'Match 
to conditional compilation directives' (i.e. when such 'compiled-out' references would normally be ignored) 

 

Show All Members 
 
Default keyboard shortcut is Ctrl + . 
 
The aim of 'Show All Members' is to improve on the VBE's Intellisense 'auto list members' dialog. This dialog is shown, typically, 
when you type a '.' following the name of a declaration that has child-members … for example, following the name of a Module 
in your VBA Project then you will see a list of the (non-Private) members of that Module; or following the name of an object such 
as an Excel Worksheet or a Word Document then typing a '.' will show you the (non-Private and non-hidden … though see Show 
/ hide hidden members) members of that object. 
 
The big downside of the VBE's dialog is that it's not very user-friendly: 
 

• It's very small (showing around half a dozen members at a time) 

• It's not searchable 

• It shows the name of the member (and the type as an icon) only 



 
 
• When you display the dialog without a parent (i.e. without a '.' … by pressing Ctrl + J or using the 'Edit' > 'List Properties / 

Methods' menu item) then every available member is displayed in one big 'flat hierarchy' list (including members from 
within your VBA Project as well as members from each Type Library that your Project has a Project reference to) 

 
The 'Show All Members' function is designed to fix this by displaying an improved dialog that: 
 

• Is much larger (and can be re-sized) 

• Is searchable and filterable by member-type 

• Shows not only the name of the member (and the type as an icon) but also its full 'signature' 

• When you display the dialog without a parent (i.e. by pressing Ctrl + . or using the 'Extras' > 'Show All Members' menu item 
while the cursor is in 'whitespace') then every available top-level member is displayed (including members from within your 
VBA Project as well as members from each Type Library that your Project has a Project reference to) … but if you prefer the 
VBE-style 'flat hierarchy' then you can enable this in the 'Code' tab of the Settings 

• Allows you to just copy (rather than insert) the name of the member if you prefer 

• If the member is a Constant or an Enum member from within a Type Library, then you can optionally insert or copy the 
value (rather than the name) of the Constant or Enum member … this is useful if using late binding or Special binding (when 
'copy value' is available, the 'Copy' and/or 'Insert' buttons of the Show All Members dialog will automatically become 'split 
buttons' allowing the value to be copied or inserted) 

• If the member has a 'doc string' then it will be shown to you if you hover the mouse pointer over the member (and if the 
'Show doc string' option is selected in the Options for the Show All Members dialog) … this includes 'doc strings' defined: 

o In your VBA code … if you include lines with code comments immediately above, say, a procedure then they will be 
shown 

o In Type Libraries … though note many Type Libraries do not define 'doc strings' for their members … to see this in 
action for a Type Library, show the Show All Members dialog for an object in the Microsoft Scripting Runtime Type 
Library (e.g. the FileSystemObject or the Dictionary) 

 

 
Figure 2 - The 'Show All Members' dialog 

 
The Show All Members dialog can be shown in the following 'contexts': 
 

• In whitespace … as noted above, all top-level members are shown (unless you have checked "Allow 'flat hierarchy'" in the 
'Code' tab of the Settings 

• Following a member … all child members of that member are shown (see Figure 2 above showing all child members of 
Excel's Workbook object) 



 
 
• Following a comparator (=, <, >, <=, >=, <>) which follows the name of a variable (or Function, Property Get etc) which has 

the value type of an Enum (either an Enum defined in your VBA code or an Enum defined in a Type Library) … see Figure 3 
where Ctrl + . has been pressed with the cursor following the '=' 

 

 
Figure 3 - Enum members 

• Following an assignment operator (=) where the variable (or Property Get) being assigned to is declared with the value type 
of an Enum (again, either an Enum defined in your VBA code or an Enum defined in a Type Library) … similar to the above 
for comparators 

• When passing an argument to a procedure or property and the respective parameter requires an Enum member … see 
Figure 4 where Ctrl + . has been pressed with the cursor following 'filename,' 

 

 
Figure 4 - Enum members as argument 

 
Show All Members – things to know 
 
If a member (or parameter etc) is declared as a Variant then Show All Members cannot show any members in the same way as 
the VBE cannot. Showing members depends on the explicit type being used. This applies when showing members for 
declarations in your VBA code and when showing members for declarations in Type Libraries … and I'm afraid that some Type 
Libraries declare far too many things as Variant … stand up, Excel! 
 
Show All Members doesn't work for the 'Debug' object (i.e. as in Debug.Print or Debug.Assert) as Debug is not actually part of a 
Type Library, being built into the VBE itself. 
 
As noted above, Show All Members uses a true hierarchy (not a 'flat hierarchy'). This means that for members of Modules and 
Enumerations, Show All Members considers those members not to be 'top level' … whereas the VBE does consider them to be 
'top level'. For example, VBE's Err keyword is a Function within the Information Module of the VBA Library. If you type Err in the 
VBE, place the cursor after it and then press Ctrl + . you will not see a list of members, rather you will see a dialog telling you that 



 
 
Err isn't accessible. This is because Err is not 'top level'. If you use VBE_Extras 'Qualify reference' function on Err, it will offer to 
prefix it with VBA.Information. You can then press Ctrl + . and see its members. 
 
If there are multiple members with the same name (e.g. a Property Get and a Let and/or Set) then they will each be shown in 
the Show All Members dialog whereas the VBE would just show one. 
 
If you Show All Members in whitespace with the "Allow 'flat hierarchy'" setting unchecked (the default), then the list shown to 
you will include: Type Library program names; VBA Project names (the active Project and any referenced Projects); Modules 
names in the active Project (Classes only if they have their VB_PredeclaredId attribute set to True … see Set 'VB_PredeclaredId' 
attribute); Enum names in the active Project; Module-level declarations in the Module that is being shown; procedure-level 
declarations in the procedure or property that the cursor is in. 
 

Special binding 

 
If you are aware of the differences between early and late binding and often develop your VBA code using the former but switch 
to the latter when deploying, then 'special binding' may be useful to you. 
 
Using VBE_Extras' capacity to parse Type Libraries allows the Show All Members function (and other functions … noted below) 
to work without having a Project reference to the Type Library – see Figure 5. 
 

 
Figure 5 - Special binding 

Here you can see that fso is declared As Object (i.e. it is late bound) but Show All Members can still show all of its child members 
(in this case, Ctrl + . has been pressed following the fso). Three things need to be in place for this to work: 
 
1. You need to have enabled 'special binding' in the 'Code' tab of the Settings. 
2. Following the declaration (in this case Dim fso As Object), you need to tell VBE_Extras what the early-bound equivalent type 

would be, this is done as a code comment on the same line as the declaration – the code comment must include the word 
As and then the type … so here it is As Scripting.FileSystemObject (though As FileSystemObject would do - but including 
Scripting is better … as it is when using early binding … to correctly qualify the type and make the process of identifying 
which Type Library the type is in simpler and less prone to name clashes). This needs to happen after each declaration that 
you want special binding to work for. 

3. At the top of the Module in which you want special binding to work, in the declaration lines (or, at least, before the first 
procedure or property is declared), you need to tell VBE_Extras which Type Library(s) you want special binding for by 
specifying the full path in a code comment – in this case it is the "Scripting" library and the code comment is ' 
<Ref>C:\Windows\System32\scrrun.dll</Ref> "Scripting" … the path must be enclosed in <Ref> tags (anything after the closing 



 
 

</Ref> tag is ignored but I find it useful to include the 'program name' for the Type Library as a reminder). You can get the 
relevant code comment for a specific Type Library using the Update Project References dialog, right-clicking on the relevant 
Type Library and selecting the 'Copy as <Ref>' menu item. This needs to happen once in each Module for each Type Library 
that you want special binding for. 

 
Other VBE_Extras Functions that support special binding are: 

• Info for code at cursor 

• Qualify reference 

• AutoText when adding a Select…Case statement using a variable, or other declaration with a value type, where that value 
type is an Enum from a Type Library 

• Add Enum from Type Library 

• Add a "GetEnumAsString()" Function 
 
The early bound equivalent type code comment 
 
You must include As in the code comment following the declaration of the variable that you want special binding to work for. 
 
For variables (including Module-level variables), statics, Functions, Property Gets and Type elements, the As Type code comment 
should be at the end of the line on which they are declared. I recommend only one declaration on any one line unless you want 
to use the same As Type for multiple variables e.g. 
 
Dim a As Object, b As Object, c As Object ' As Outlook.Folder 

 
… will set the early bound equivalent type to Outlook.Folder for each of a, b and c. 
 
For parameters, the As Type code comment should be in a line either above or below the procedure / property declaration and it 
should be preceded by the name of the parameter e.g. 
 
' --------------------------------------------------------------------------------------------------------------------- 

' Purpose: Do something 

' Param fso As Scripting.FileSystemObject: A file system object that we will do something with 

' Param dict As Scripting.Dictionary: A dictionary that we will do something with 

' --------------------------------------------------------------------------------------------------------------------- 

Sub DoSomething(fso As Object, dict As Object) 

    ' code 

End Sub 

 
… will set the early bound equivalent type to Scripting.FileSystemObject for fso and to Scripting.Dictionary for dict. 
 
The As Type can be enclosed in parenthesis if desired, for example the following is also valid: 
 
' Param fso (As Scripting.FileSystemObject): A file system object that we will do something with 

 
The As Type code-comment can be on a subsequent physical line (i.e. following a line-continuation character) if required, 
however, everything from the apostrophe starting the code-comment to the type must be on a single physical line. 
 
Special binding – things to know 
 
As noted above, you must include As in the code comment following the declaration of the variable that you want special 
binding to work for! 
 
If a member (or parameter etc) is declared as a Variant or Object then special binding cannot show any members for it (or show 
'Info for code at cursor' for it, or 'Qualify reference' for it) – special binding depends on explicit types being used. 
 
All Project references have a specific priority order (note the order of Project references in the VBE's References dialog or in 
VBE_Extras equivalent Update Project References dialog) such that if multiple Type Libraries (or VBA Projects … whatever the 
reference is to) have a member with the same name, the reference with the higher priority 'wins'. The Type Library(s) 
"referenced" by <Ref> code comments are considered to have a lower priority than all actual Project references and are in the 
order they are specified in the Module (lowest line number = highest priority). If a single Type Library is referenced via an actual 
Project reference and via a <Ref> code comment then the <Ref> code comment will be ignored. 
 
The path in the <Ref> code comment must be an absolute path (not a relative path). 
 



 
 
Special binding works with hidden members of Type Libraries if you are showing hidden members (see  Show / hide hidden 
members). 
 

Declarations 
 

Show declaration for code at cursor 

 
If the cursor if on a declaration or reference, then you will be shown information for that declaration  
 

List declarations in this Procedure / Property 
 
Displays a dialog with a list of declarations in the Procedure or Property that the cursor is in. 
 

List declarations in this Module 

 
Displays a dialog with a list of declarations in the active Module. 
 

List declarations in this Project 
 
Displays a dialog with a list of declarations in the active Project. 
 

List declarations referenced from other Modules in this Project 

 
Displays a dialog with a list of declarations in the active Module that are referenced from any other Module of the same Project.  
 
Excel only: for clarity, this excludes references from the OnAction property of Shapes (i.e. OnAction is not considered to be a 
reference from another Module). 
 

Refactor 
 

Rename code at cursor 

 
Default keyboard shortcut is Ctrl + Shift + R 
 
If the cursor if on a declaration or reference, then you can rename that declaration and all references to it (including references 
in other open VBA Projects where those Projects have a reference to the Project containing the declaration … see Referenced 
VBA Projects for more info).  
 
When renaming, VBE_Extras does not simply find and change all occurrences of a name, rather if there are multiple Declarations 
with the same name in the same scope then it can apply code-parsing rules to determine which references relate to which 
declaration and only the appropriate instances are changed. 
 
If the declaration is a Property then any matching Property (i.e. Get, Let and Set) will be renamed. Also, VBE_Extras will offer to 
rename any backing Module-level variable or Type element where a match could be identified (to match, the variable or Type 
element must be referenced within the body of the Property and must have a matching name other than any prefix e.g. 'm' for 
Module-level, and both must be in the same Module). 
 
If the declaration is a Getter (Function) or Setter (Sub) then any matching Getter or Setter will be renamed and again VBE_Extras 
will also offer to rename any backing variable or Type element with the same rules as above for a Property. 
 
If the declaration is a backing member itself, then VBE_Extras will offer to also rename the related Properties or Getter/Setters – 
again applying the same rules. In addition, the following must be true: 

• The backing member is a Module-level variable, or 

• The backing member is a Type element and there is only one Module-level variable defined as that Type element's parent 
Type in the same Module 

 
When renaming declarations that have references on excluded lines (due to conditional compilation directives) then you will be 
shown a dialog asking whether you want to rename the 'out of scope' references as well as the 'in scope' references (i.e. to 



 
 
ensure that your Project continues to compile and run if the currently 'out of scope' code becomes 'in scope'). For more on this, 
see Conditional compilation. 
 
Excel only: when renaming a Sub or Function in a standard Module, any Shape that has an OnAction property that references 
that Sub or Function will have its OnAction property updated for the new Sub / Function name. In addition, when renaming a 
standard Module, any Shape that has an OnAction property that explicitly references that Module (as part of the reference to a 
Sub / Function) will have its OnAction property updated for the new Module name. 
 
Renaming will block certain names (such as same name already used in same scope when VBA rules say that doing so would be 
invalid; reserved words; for Class Modules that are Interfaces, names that include characters that would prevent its use as an 
Interface) and warn about others (such as a name that is already used in the same scope and so the new name would be 
'hidden'). 
 
Renaming supports renaming of all types of declarations including: 

• The Project 

• Modules (document, standard, Class and UserForm) 
o … including Class Modules that are Interfaces 
o … but not ThisOutlookSession in Outlook 

• Enums and Enum members (including Enum member names that require 'square brackets') 

• Types and Type elements 

• Procedures and Properties 

• 'Declare' Procedures (ie those that access the Windows API) 

• Events 

• Controls on UserForms (and Access Reports and Forms … including handling event handler prefixes, the 'EventProcPrefix') 

• Variables (Module-level and Procedure/Property-level) 

• Constants 

• Line labels 
 
Attributes names for Module-level members (Procedures, Properties, variables and constants) are also updated. 
 
The rename function will assist with renaming declarations when only the case of the declaration needs to be changed. The 
preferred casing for each type of declaration can be set in the Settings 
 
The Project needs to have been saved at least once for the rename function to work. 
 

Undo rename 

 
Reverses the last rename operation unless you have subsequently edited the renamed declaration itself or have carried out 
other edits that prevent the tracking of all renamed references. 
 

Qualify reference 
 
If the cursor is on a reference that is to a Module-level member of another standard Module of the same Project (i.e. a standard 
Module other than the Module the reference is in), this will qualify the reference with the name of that other standard Module 
if it is not already qualified e.g. if procedure MyProc is defined in Module1 and is called from a procedure in Module2 as just 
MyProc then this will convert the call to Module1.MyProc 
 
If the cursor is on a reference that is to a Module-level member of another standard Module in another referenced-to (ie 'child') 
Project, this will qualify the reference with the name of that other Project and Module if it is not already qualified. 
 
If the cursor is on an Enum member, this will qualify the Enum member with either the Enum name, the Project name (if 
relevant) or both e.g. if Enum member THIS_MEMBER is defined in MyEnum and is referenced as just THIS_MEMBER then this will 
convert it to MyEnum.THIS_MEMBER (assuming the Enum is declared in the same Project). 
 
The 'Code' tab of the VBE_Extras Settings includes options for the Qualify reference function. 
 
'Qualify reference' is also 'Type Library aware' (and works with Special binding) – for example if you type 
 
Dim fso As FileSystemObject 



 
 
 
… and then place the cursor on FileSystemObject and trigger 'Qualify reference' then it will update the line to 
 
Dim fso As Scripting.FileSystemObject 

 
… assuming, of course, that your Project currently has a reference to the Microsoft Scripting Runtime Type Library. 
 

Add Properties 
 
Auto-add a Property Get, Let and (where appropriate) Set for a Module-level variable or a Type element. Cursor must be on the 
name of the variable / element within its declaration. Cannot add Properties for variables or Type elements that have a value 
type of a fixed-length String, another Type, or a static array. 
 
Use the 'Code' tab of the VBE_Extras Settings to set various defaults for the Properties. 
 
To see more background on automatically adding Properties, see my blog post 
https://www.thevbahelp.com/post/automatically-adding-properties  
 

Add Factory 
 
Auto-add a Factory and associated Property Let and/or Set (and, optionally, Get) for a Type or one or more Module-level 
variables. Cursor must be on the name of the Type, a Type element or one of the Module-level variables within its declaration, 
and the variable or Type element must be in a Class Module. It is not possible to add Properties for variables or Type elements 
that have a value type of a fixed-length String, another Type, or an array. 
 
Adding a factory also sets the VB_PredeclaredId attribute to True so that the Class has a default instance allowing Class instances 
to be created using code such as 
 
Dim c1 As Class1 
Set c1 = Class1.Create("Hello World", 42) 

 
Use the 'Code' tab of the VBE_Extras Settings to set various defaults for the Factory and associated Properties. 
 
To see more background on factories, what they are and why to use them, see my blog post 
https://www.thevbahelp.com/post/automatically-adding-factories  
 
If the name of any of the Property Let/Set/Get(s) added as part of the Factory would clash with an existing member or clash with 
a VBA keyword, then a numeric suffix will be added e.g. if you add a Factory for a Type and that Type includes an element 
'sglNew As Single' and you have the Setting for 'New property prefix behaviour' set to 'Remove entire prefix', then the new 
Property will be named 'New1' (and not 'New' which would clash with the VBA keyword of the same name). 
 

Extract to constant 

 
Extract literal values to a constant. The cursor must be on a literal value or the name of a constant in the Const declaration. 
Excludes literal values used in conditional compilation (either as the value assigned to a #Const or in an #If or #ElseIf statement). 
 
If the cursor is on a literal value other than in the Const declaration 
 
A new constant will be created and all literal values matching that at the cursor will be updated to use the constant. You can 
define the scope the literal values are extracted from, where the Const declaration will be put, the name and value type of the 
Const declaration and whether literal values within code comments are extracted or not. If the literal value is a String then 
matching can be case sensitive or not (the new constant will use the case of the String at the cursor). 
 
Literal values that are the default values of optional Procedure / Property parameters are Module-level (not Procedure / 
Property-level) and will only be extracted to a Const if the scope to extract from is Module or Project (not if the scope is 
Procedure / Property). 
 
VBE_Extras will first check for any existing Consts anywhere in the Project that define the same value. If any are found, a dialog 
will be shown. 
 

https://www.thevbahelp.com/post/automatically-adding-properties
https://www.thevbahelp.com/post/automatically-adding-factories


 
 
If the cursor is on the name of a constant in the Const declaration or on the literal value being assigned to that Const 
 
VBE_Extras will search for other matching literal values and replace them with the name of the Const. If Const is a String then 
matching to other literal values can be case sensitive or not. 
 
Only the scope of the Const will be used for the search for other literal values … if the Const is declared: 

• Public in a Module then the scope will include other literal values within all Modules of the VB Project 

• Private (or default) in a Module then the scope will include other literal values within that Module 

• In a Procedure / Property then the scope will only include other literal values within the same Procedure / Property (not 
including default values for optional parameters) 

 
Note that this function only works with a Const that uses a single literal value and not with a Const that uses an expression that 
needs evaluating (eg Const MY_NUM As Long = 21 + 21) 
 
General 
 
Some literal values will not be extracted to a Const: those that are already the value used in a Const or #Const declaration; those 
used in a conditional compilation directive line (eg #If, #ElseIf); those used in a Declare Sub / Function line. 
 
If 'Match conditional compilation directives' is selected in the Settings then literal values on excluded lines will not be extracted. 
 
To see a list of literal values, see Matches for literal value at cursor but note that function can display ALL matching literal values 
whereas Extract to constant is sensitive to code scoping rules. 
 
To understand in more detail how a 'match' between literal values is determined, see Matches for literal value at cursor. 
 
Extract to constant is single-Project and will only extract values from within the same Project. 
 

Implement Interface 
 
Only Class Modules and UserForm Modules can implement an Interface. 
 
To be considered an Interface, a Module must: 

• Be a Class Module 

• Not implement another Interface 

• Have one or more Public members - either a Property, a Sub or a Function with an empty body, or a field 

• None of the Public members must have an underscore in their name 

• Not include any conditional compilation 1 

• Be in the same Project as the Class or UserForm Module that it is to be implemented in, or be in a 'child' Project 2 

• If the host application is Access, the Interface name must not include characters (e.g. a space character) that would require 
the use of square brackets 3 

• If the host application is Access and the Interface is in a 'child' Project, the 'child' Project name must not include characters 
that would require the use of square brackets 3 

 
1 this is a requirement of VBE_Extras, not a requirement of VBA 
2 if in a 'child' Project, the Interface must have its VB_Exposed attribute set to True … VBE_Extras will set this when 

implementing the Interface 
3 as the Implements keyword does not allow the use of square brackets 
 
If a Module could be considered to be an Interface but is already implemented by the target Module (both an Implements 
statement and each required member is present†) then VBE_Extras will not include the Interface in the list of those that it can 
implement for a particular Module ... however, if the Implements statement is missing or any one (or more) of the members is 
missing then VE will include the Interface in the list of those that it can implement and will add only the relevant code 
(Implements statement and/or members). 
 
† only the presence of a Procedure / Property with the right name and unit type is checked ... the parameters and (if relevant) 

returned value type are not checked 
 
As well as the required Interface members, VBE_Extras will offer to add to the implementing Class / UserForm: 



 
 
• Object members - so that the Interface members are accessible when client code is working with instances of the 

implementing Class / UserForm 

• Fields for implemented Properties (along with code to set/get the field's value) - if no clashing members already exist in the 
implementing Class / UserForm 

 
If the implemented Interface is in a 'child' Project then the Interface Class Module will have its VB_Exposed attribute set to True 
(if it is not already) to comply with VBA rules. 
 

Extract Interface 

 
Create a new Interface from one or more members of a Class or UserForm Module. The Class or UserForm Module must have 
one or more Properties or Procedures that: 

• Do not have an underscore in their name 

• Do not have a value type of a Type, fixed-length String or array (static or dynamic) 

• Do not have a value type of an Enum that is defined in the same Class or UserForm Module that the interface is to be 
extracted from 

 
A new Interface (a Class Module) will be created and that newly created Interface will be implemented in the Class or UserForm 
Module – the added Interface members can either be empty or can call to the (existing) members that were used to create the 
Interface. 
 
The new Interface can be added to the same Project or to a 'child' Project (so long as that child Project has a name that does not 
require the use of square brackets ... as the VBA 'Implements' keyword does not support square brackets). If the Interface is 
added to a child Project then the (newly created) Class Module that is the Interface will have its VB_Exposed attribute set to 
True. 
 

Make 'Option Explicit' 
 
Make 'Option Explicit' is only available when the Office Display Language is set to be English. 
 
For a Module that does not currently have an Option Explicit statement, adds that statement and then adds explicit 'Dim' 
declarations for all undeclared variables. Optionally, will create a report of all variables added and where they were added. 
 
IMPORTANT: 

• You must ensure your Project has no other compilation errors (i.e. in the VBE menu, Debug > Compile does not result in an 
error dialog) before using this function 

• If you need to exit the Make 'Option Explicit' process, hold down the Alt key 

• Do not use the keyboard (other than the Alt key to exit, if required) or click with the mouse while this function is executing 
... doing so will interfere with the process and likely cause the process to end before completion (however, you can just start 
the process again) 

• No progress bar is shown while the process is running (a progress bar would interfere with the process and so cannot be 
shown) 

• Your PC may repeatedly 'ding' while the process is running … this is normal and cannot be prevented (turn down your 
volume if required) 

• Pauses of a few seconds can occur while this function is running … this is normal … when the process is complete, a dialog 
will be displayed 

 
Note that: 

• Make 'Option Explicit' does not take conditional compilation into account ... you will have to manually check that the 
declarations added cover all conditional compilation scenarios 

• When the same variable appears in multiple procedures / properties, you will be asked whether you want to add one 
declaration at the Module-level or in each procedure / property 

• All variables are added 'As Variant' 
 

Tasks in this Project 
 
Default keyboard shortcut is Ctrl + Shift + T 
 



 
 
Displays a dialog with a list of all tasks (aka TODOs) in the active Project. Tasks are always in code comments that use an 
apostrophe (not a Rem statement). 
 
The specific text that defines a 'task' can be customised, along with the 'priority' level in the VBE_Extras Settings. The specific 
text can immediately follow the code-comment apostrophe or have one or more space characters in-between. Any other 
character in-between will prevent the task from being identified.  
 

Goto 
 

Go to declaration for code at cursor 

 
Default keyboard shortcut is F12 
 
Just as it sounds, if the cursor is on a reference, then the cursor will be moved to that reference's declaration. Very similar to 
pressing the Shift + F2 keys (which activates the VBE's built-in 'go to declaration' function), but this works for more types of 
declaration and is more accurate. 
 
There are limitations when the declaration is a Control in an Access Form or Report … see Using VBE_Extras in Access. 
 

Go to a declaration in this Module 
 
Default keyboard shortcut is Ctrl + Shift + A 
 
Displays a dialog with a list of all declarations in this Module, allows you to select one to 'go to'. 
 

Go to line in this Module 
 
Default keyboard shortcut is Ctrl + Shift + L 
 
Enter a line number, go to it. Optionally follow the line number by a comma then a column number to go to a column within the 
line. 
 

Go to Module 

 
Default keyboard shortcut is Ctrl + Shift + M 
 
Display all Modules in the active Project, allows you to select one Module to 'go to'.  
 
Note that Class Modules that are Interfaces are distinguished using a separate icon from the normal Class Module icon. 
 
If 'Indicate VB_PredecaredId' is checked in the Settings dialog then the names of Class Modules that have the VB_PredeclaredId 
attribute set to True will be followed by 'PdI'. If 'Indicate VB_Exposed' is checked in the Settings dialog then the names of Class 
and UserForm Modules that have the VB_Exposed attribute set to True will be followed by 'Exp'. 
 

Go to implementation 

 
For a member of an Interface (i.e. a Class Module being used as an Interface), go to an implementation of that member. 
 
For the Class Module itself, if clicked in the Project window (where that Class Module is an Interface), go to a Class that 
implements the Interface. 
 

Go to base 
 
For a member of a Class or UserForm Module (where that Module implements an Interface), go to the base for that member in 
the Interface. 
 
For the Class or UserForm Module itself, if clicked in the Project window (where that Module implements an Interface), go to the 
Interface. 



 
 
 

Go to previous code reference in this Project / Go to next code reference in this Project 

 
Default keyboard shortcut is Ctrl + Shift + PgUp / PgDown 
 
Go to the previous or next code reference of a declaration for the code at the cursor. 
 
This excludes references in code comments, in Strings or (for Excel) the OnAction property of Shapes. These functions are single-
Project only (will not go to references in other Projects). 
 

Go to declaration above / Go to declaration below 

 
Default keyboard shortcut is Ctrl + Shift + , / . 
 
Go to the Module-level declaration above or below the current cursor position within the Module currently displayed. 
 

Go to Bookmark in this Project 
 
View the bookmarks in the active Project, optionally 'go to' one. 
 

Go to Shape with this name or that calls this Procedure 

 
This function is available in Excel only. The Project must have been saved at least once for this function to work. This function is 
single-Project and will only find Shapes in the Workbook that is associated with the active Project. 
 
If the cursor is on the name of a Sub or Function in a standard Module 
 
For a Sub or Function in a standard Module, if it is the target of one or more Shapes' OnAction property (as set using 'Assign 
Macro') then go to that Shape in the relevant Worksheet or Chart sheet. 
 
For the reverse action, see Go to OnAction 
 
If the cursor is on a String literal or Const 
 
For the String literal or Const (with a String value-type, or a Variant value-type holding a String), go to the Shape with that name 
in the relevant Workbook or AddIn: 

• If the VBA Project containing the String literal / Const is in a Workbook, only that Workbook is searched for the Shape 

• If the VBA Project containing the String literal / Const is in an AddIn: 
o The AddIn itself will be searched first (even though an AddIn has no user-interface, it can still contain Shapes) 
o If there is an active Workbook (in the Excel user-interface) then search that second 

 
Note this function is not 'code-context sensitive' i.e. it does not attempt to parse the code to determine which Worksheet or 
Chart sheet (within the Workbook or AddIn) the Shape is in … or even if the String literal / Const is referring to a Shape at all, 
rather if multiple Shapes with the same name exist (ie in multiple Worksheets / Chart sheets) then they will all be listed for you 
to select one. 
 
For the reverse action, see Uses of Shape's name 
 

Go to Table with this name 
 
The same as Go to Shape with this name or that calls this Procedure when the cursor is on a String literal or Const but for Tables 
(and note that Table names are unique within a Workbook so you will never be shown a list of Tables to select one). 
 
For the reverse action, see Uses of Table's name 
 

Go to Name with this name 
 



 
 
The same as Go to Shape with this name or that calls this Procedure when the cursor is on a String literal or Const but for Names 
that refer to a (fixed) Range. 
 
For the reverse action, see Uses of Name's name 
 

Sub to run 
 
The 'Sub to run' functions are not available in Outlook and the Project needs to have been saved at least once for the 'Sub to 
run' functions to work. 
 
Note that when Word is the host application, you may see the screen flickering when you 'Run Sub to run' or 'Run Again' … this 
is because Word requires the Document that contains the Sub being run to be the active Document and so VBE_Extras makes 
the Document active and then re-activates the VBE. 
 
Despite the name, all of these functions work on VBA Functions, as well as VBA Subs. However, they must be in standard or 
document Modules and must have no parameters. 
 

Set Sub to run / Run Sub to run / Clear Sub to run 

 
Default keyboard shortcut for 'Run Sub to run' is F6 
 
Want to edit code in one place in your Project and quickly be able to run the code from another point … these are the options 
for you. 
 
If you press the keyboard shortcut for 'Run Sub to run' and no Sub is set, VBE_Extras will assist you to select a relevant Sub. 
 
'Run Sub to run' also gives you the option to either jump to the end of, or clear, the Immediate window before the Sub is run 
(set this option in the 'Run' tab in the Settings). 
 

Run Again 

 
Default keyboard shortcut is F10 
 
The 'Run Again' function can be enabled / disabled in the 'Run' tab in the Settings. 
 
When 'Run Again' is enabled, VBE_Extras records the Sub you last ran via F5 or via the Run > Run Sub/UserForm menu item. 
Then, when you select to 'Run Again', that Sub is then run. Meaning you don't have to keep navigating around trying to find the 
Sub in order to run it … and you don't have to navigate around trying to find the code you were editing afterwards. 
 
'Run Again' also gives you the option to either jump to the end of, or clear, the Immediate window before the Sub is run (set this 
option in the 'Run' tab in the Settings). 
 
Note that: 

• VBE_Extras only records the Sub you last ran via F5 or via the Run > Run Sub/UserForm menu item and not when code is run 
via any other method e.g. not when code is run via event handlers, RibbonX callbacks, F8, or clicking a Shape, or via 
Application.Run or via the 'Macros' dialog or via VBE_Extras 'Run Sub to run' function … or any thing else other than F5 or 
the Run > Run Sub/UserForm menu item 

• If you use Run > Run Sub/UserForm to 'run a UserForm' then the Sub to 'Run Again' will be cleared 

• 'Run Again' only works for code that is run within Projects that have been saved at least once 
 

Immediate window 
 

Go to start / Go to end / Clear 
 
Default keyboard shortcut is Ctrl + Shift + S / E / C 
 
Yep, do these things to the Immediate window 
 



 
 
The Project needs to have been saved at least once for the 'Immediate window' functions to work. 
 
Also, you can configure VBE_Extras to automatically clear or go to the end of the Immediate window when a Sub (or Function) is 
run using F5 or using the Run > Run Sub menu item (set this option in the 'Run' tab in the Settings). 
 

Lines 
 

Add / update line numbers 

 
Add / update line numbers – to either the Project, a whole Module or to a specific Procedure / Property. 
 
If existing line numbers are 'referenced' (e.g. in GoTo, GoSub or Resume statements) then references will be maintained when 
updating line numbers. 
 
Options for the first line number, the step to subsequent line numbers, and whether line numbering is reset at the Module level 
or at the Procedure / Property level are available in the 'Other' tab of the Settings. 
 
Preserves Attributes if present. 
 

Remove line numbers 
 
Remove line numbers – from either the Project, a whole Module or from a specific Procedure / Property. 
 
If existing line numbers are 'referenced' (e.g. in GoTo, GoSub or Resume statements) then those line numbers will not be 
removed in order to keep code 'compile-able'. If you wish to remove 'referenced' line numbers, you should convert them to line 
labels. 
 
Preserves Attributes if present. 
 

Indent lines 
 
Apply code indentation rules – to either the Project, a whole Module, the Module declaration lines or to the current Procedure / 
Property. 
 
Handles line numbers if present. When line numbers are present, it can appear that too much whitespace is left between the 
line number and the indented code, however, this is because the 'End' line of a Procedure or Property CAN have a line number 
(though typically doesn't … even when line numbering is applied) and space is left for it even if it is not present. 
 
Preserves Attributes if present. 
 
There are options relating to indenting in the 'Indent' tab of the  Settings: 

• Size of indent (in characters) 

• Whether to indent within conditional compilation blocks 

• Whether to indent within On Error blocks 

• Whether to apply indentation rules to lines before the first code line of a Procedure / Property 

• The size of indent for continued lines 
 
Note that line labels are required to always start in column 1 (i.e. to have no indent). 
 
Oddities … while VBE_Extras does indent the following types of lines correctly, by the time the line is displayed to you by the 
VBE, the indentation has been changed (by the VBE … try to indent them manually and see!): 

• Lines that start with a colon are always forced to column 1 by the VBE 

• Lines that consist only of the line continuation characters (i.e. " _") are always forced to column 1 by the VBE 
 

Split line(s) 
 
Split the logical line(s) at the cursor into individual physical lines (using the line continuation characters sequence " _"). 
Additionally, if a line is already split (but at a point that doesn't align with your settings) then the line with be joined. 



 
 
 
Use the Settings to set your preferences for: 

• The maximum physical line length 

• Whether a logical line that is split into multiple statements using ':' should be broken down into discrete logical lines for 
each of those statements before the 'split' takes place or whether the multiple statements should be treated as one long 
logical line 

• Whether a '.' and a '&' (to split Strings) should be positioned at the end of the (previous) physical line or at the start of the 
(next) physical line 

 
These settings are also applied when VBE_Extras automatically adds a line of code to your project, for example when using: 

• The Add Factory function - the Create() function declaration can have a lengthy line if it has many parameters, and 

• The Make 'Option Explicit' function - if many declarations are added on the same line 
 

Comment / Uncomment line(s) 
 
Default keyboard shortcut is Alt + C / Alt + Shift + C 
 
Comment / uncomment the line(s) at the cursor. If  'Comment / Uncomment expands' is selected in the Settings then the lines 
commented / uncommented will be expanded to the start and to the end of a logical line of code (i.e. where line continuations 
are involved). 
 
Note that commenting line(s) of code that have Attributes will remove those attributes. The VBE itself does not allow 
commented lines to have attributes. 
 

Move line(s) up / down 

 
Default keyboard shortcut is Alt + Up arrow / Down arrow 
 
Move the selected line(s) up or down by one line. Note this does not apply any 'code sense' to the selected line(s) … it will move 
just the selected line(s) whether they are lines ending with continuation characters (or are being moved into other lines ending 
with continuation characters). 
 
Attributes are preserved except for where line continuations are broken as a result of the operation. It is not possible to 
preserve Attributes for 'broken' lines. 
 

Other tools 
 

Attributes 

 
For more on VBA attributes, what they do, how to use them, and examples, see the 'VBA attributes' blog post at 
https://www.thevbahelp.com/post/vba-attributes  
 
Note that the Main menu and the Code window context menu have options to view/set all attributes (both Module attributes 
and Procedures, Properties, variable and constant attributes); the Project window context menu has options to view/set Module 
attributes only. 
 
All VBE_Extras functions that update your VBA code will preserve existing Module attributes. The majority of VBE_Extras 
functions that update your VBA code will preserve existing Procedures, Properties, variable and constant attributes, for 
example: 

• Rename code at cursor – if the member being renamed has an attribute, it will be retained (and updated to match the new 
name of the member) 

• Move line(s) up / down – if the line that is being moved up or down has an attribute, it will be moved with the line; if the 
line being 'moved over' has an attribute then it will be retained 

 
However, some VBE_Extras functions can't preserve any existing attributes (e.g. Comment / Uncomment line(s) … in this case 
because the VBE does not allow attributes on commented-out lines) and you will be warned, when an attribute is present that 
will be removed, before the function is performed. 
 

https://www.thevbahelp.com/post/vba-attributes


 
 
Procedures, Properties, variable and constant attributes 
 

View attributes 

 
View all Procedure, Property, variable and constant attributes in the active Module. 
 

Set 'VB_Description' attribute 
 
Set the value of the VB_Description / VB_VarDescription attribute for a Procedure, Property or Module-level variable or Module-
level constant in a standard, Class or UserForm Module. You must right-click on the specific member name (i.e. not within the 
declaration or body of the member). Additionally: for an event handler, you must right-click on the event part of the name (not 
the name of the Object that omits the event) to the right of the underscore; for a variable or constant, the variable or constant 
must be declared on its own line (i.e. not multiple on a single line delimited by a comma or colon). 
 
Once applied, a description can be seen in the VBE's Object Browser window. 
 
VBE_Extras cannot set a description for members of Document Modules as Document Modules cannot be re-imported following 
the attribute being added / changed. 
 
All descriptions have a max length of c 900 characters; speech marks are automatically 'escaped' for you. 
 

Set 'VB_UserMemId = 0' Attribute 
 
Set the value of the VB_UserMemId / VB_VarUserMemId attribute to 0 for a Procedure, Property or Module-level variable or 
Module-level constant in a Class Module. You must right-click on the specific member name (i.e. not within the declaration or 
body of the member). Additionally, for a variable or constant, the variable or constant must be declared on its own line (ie not 
multiple on a single line delimited by a comma or colon). 
 
Only one member in any one Class Module can have this attribute set with a value of 0. This attribute makes that member the 
default member of the class. Note also that this attribute is mutually exclusive with the 'VB_UserMemId = -4' attribute (i.e. any 
one member cannot be both the default member and return an enumerator). 
 

Set 'VB_UserMemId = -4' Attribute 
 
Set the value of the VB_UserMemId attribute to -4 for a Function or Property Get in a Class Module. You must right-click on the 
specific member name (i.e. not within the declaration or body of the member). 
 
Only one member in any one Class Module can have this attribute set. This attribute makes that member return an enumerator 
such that a Collection member of the class can be enumerated using a 'For Each' loop.  Note also that this attribute is mutually 
exclusive with the 'VB_UserMemId = 0' attribute (i.e. any one member cannot be both the default member and return an 
enumerator). 
 

Module attributes 

 

View attributes 
 
View the attributes in the Module header for a Module of any type (document, standard, Class or UserForm). 
 

Set 'VB_Description' attribute 
 
Set the value of the VB_Description attribute in the Module header for a standard, Class or UserForm Module. 
 
Once applied, a description can be seen in the VBE's Object Browser window. 
 
VBE_Extras cannot set a description for Document Modules as Document Modules cannot be re-imported following the 
attribute being added / changed. 
 



 
 
All descriptions have a max length of c 900 characters; speech marks are automatically 'escaped' for you. 
 

Set 'VB_PredeclaredId' attribute 
 
Set the value (to True or False) of the VB_PredeclaredId attribute in the Module header for a Class Module. The default for a 
newly added Class Module is always False. Setting this to True gives the Class Module a default instance.  
 
If you want to view the VB_PredeclaredId state for all Modules in a Project, you can use the 'Go to Module' dialog (without 
actually 'going to' a Module). See Go to Module for more details. 
 

Set 'VB_Exposed' attribute 
 
Set the value (to True or False) of the VB_Exposed attribute in the Module header for a UserForm (or Class Module … though 
this can be adjusted anyway for a Class Module in the VBE Properties window). The default for a newly added Module (either 
UserForm or Class) is False. Setting this to True makes new instances of the Module public (though it does not make it externally 
'creatable'). 
 
If you want to view the VB_Exposed state for all Modules in a Project, you can use the 'Go to Module' dialog (without actually 
'going to' a Module). See Go to Module for more details. 
 

Matches for literal value at cursor 

 
If the cursor is on a literal value (or on the name of a constant in a Const or #Const declaration) then this will display a dialog 
with a list of all matching literal values in the active Project. The dialog will allow you to set the scope of values shown (Project, 
Module or Procedure/Property – based on the location of the literal value at the cursor), to show or hide literals that are in code 
comments and, for String literals, whether matches must be case sensitive or not. 
 
If 'Match conditional compilation directives' is selected in the Settings then literal values on excluded lines will not be shown. 
 
How is a 'match' determined? 
 
All literals are broken down into 4 'literal types': Strings (including fixed-length), numerics (all numeric types), Dates and 
Booleans. 
 
Matches do not happen across 'literal types' e.g. a String "42" will not match to a numeric 42. 
 
Matching does not distinguish within 'literal types' e.g. a numeric 42 assigned to a Long is the same as 42 assigned to a Double. 
 
When matching numeric 'literal types', type-declaration characters are ignored e.g. 42& is the same as 42 … however, different 
bases do not match e.g. &H2A is not the same as 42. 
 

Orphan declarations 
 

In this Procedure / Property / Module / Project 

 
Identifies orphan declarations within the selected scope (i.e. procedure/property, Module or Project). 
 
The orphan functionality has the option of 'old style' (that has been in VBE_Extras since it was first developed) or 'new style' 
(which is experimental). The differences between 'old style' and 'new style' are: 
 

 'Old style' orphan functionality 'New style' orphan functionality 

Identifying 
variables 
(procedure / 
property-level 
and Module-
level) as orphans 

Identifies a variable as an orphan only if it has no 
references to it at all 

Identifies a variable as an orphan if it has no 
references to it, or if all references only write to it 
(i.e. never read from it), or if all references only 
read from it (i.e. never write to it). In addition: 

• A variable passed to another procedure / 
property 'ByVal' is a 'read-only' reference and 
the variable will be listed as an orphan if it is 



 
 

not written-to elsewhere in the owning 
procedure / property 

• A variable being passed to another procedure 
/ property 'ByRef' (which is the default if not 
specified) is a 'read/write' reference and the 
variable not be listed as an orphan 

Identifying Events 
as orphans 

Identifies an Event as an orphan only if it has no 
references to it at all (i.e. it is never Raised and 
never handled) 

Identifies an Event as an orphan if it has no 
references to it, or if all references only Raise the 
Event, or if all references only handle the Event 

Identifying 
Controls as 
orphans 

Never an orphan Will be identified as an orphan if no references to 
it exist (references include direct references of the 
Control object or Event handlers for the Control). 
As certain types of Control (notably Labels, Frames 
and Images) often, though not always, do not have 
direct references or Event handlers (but are still a 
valid part of a UI layout) then they can be excluded 
from the list of displayed orphans, using the drop-
down (the drop-down is only shown when 
Controls are present in the list of orphans) 

In the list of 
displayed orphans 

No 'Orphan Info' column is shown An 'Orphan Info' column is shown identifying 
whether the member is 'Unused' (which matches 
the 'old style' functionality that an orphan must 
have no references to it at all), 'Never let' or 
'Never set' (i.e. the member is read from but never 
written to) or 'Never read' (i.e. the member is 
written to but never read from) 

 
'New style' orphan functionality can be enabled in the 'Experimental' tab of the Settings. 
 
The orphan functions will not report a Sub or Function to be an orphan if: 
 

• It is an Event handler (e.g. for ActiveX controls or Events defined in Class Modules … but see Detached event handlers) 

• In Excel, it is referenced in the OnAction property of a Shape 

• In Excel, it is the target of a keyboard shortcut set via the 'Macro Options' (Alt+F8) dialog or via the 
Application.MacroOptions() method 

 
Declarations will be considered to be an orphan if they are only referenced by: 
 
1. Code in other Projects and those other Projects are not open or the 'Multi-Project' option in Settings is not checked  
2. In Word, MacroButton Fields or FormFields  
 
Note that: 
 

• VBE_Extras cannot read Ribbon XML and so callbacks from Ribbon XML, by default, are considered to be orphans … 
however, you can change this using the 'Ribbon XML callbacks are not orphans' option in the Settings such that a Sub in a 
standard Module that takes a parameter of type IRibbonUI or IRibbonControl is excluded from the orphans list 

• Strings are not normally considered to be 'code' references and so a string with the same name as a declaration (with the 
parent Module and/or Project as appropriate) would not normally stop a procedure declaration from being considered to 
be an orphan, however, you can change this using the 'Procedures called by strings are not orphans' option in the Settings 
such that a Sub or Function in a standard or document Module that is referenced from a single string literal or a single Const 
in a call to, for example, Application.Run or Application.OnTime is excluded from the orphans list … note the reference must 
be from a single string literal or a single Const without any form of manipulation (eg concatenating multiple string literals or 
Consts; using a variable) 

• To stop a specific procedure from being flagged as being an orphan, you can Insert '@EntryPoint' 
 
Access only: see Using VBE_Extras in Access  
 

Orphan Modules 
 



 
 
Checks whether Standard, Class and UserForm Modules are unused. Document Modules (e.g. ThisWorkbook and Sheet Modules 
in Excel; Form and Report Modules in Access) are never orphans as they are fundamental elements of the parent file (e.g. 
Workbook in Excel; Database in Access). 
 
A Standard Module is considered to be unused if none of the members it contains are referenced. 
 
A Class or UserForm Module is considered to be unused if it is never referenced (e.g. in a Dim or With statement). 
 

Declarations that could be made Private 

 
That is, find declarations that are only referenced from within their own Module 
 
Note that this function only looks in the VBA code for references. To prevent a Procedure from being incorrectly flagged as being 
one that could be made Private, you can Insert '@EntryPoint' 
 

Detached event handlers in this Project 
 
That is, event handlers that handle events for objects that no longer exist. For example, if you have a UserForm with a 
'CommandButton1' control then you might have an event handler 'CommandButton1_Click' to handle it's click event. If 
'CommandButton1' is then deleted or renamed but 'CommandButton1_Click' is not, then you have a detached event handler. 
This function will find that detached event handler. 
 
This function is single-Project only (it will find only detached event handlers in the active Project). 
 

Keyboard shortcuts in this Project 
 
Only available in Excel. 
 
Shows keyboard shortcuts applied with the 'VB_ProcData.VB_Invoke_Func' attribute - that is, those applied using the 'Macro 
Options' (Alt+F8) dialog and those applied using the Application.MacroOptions() method ... specifically, it does not show 
keyboard shortcuts applied programmatically using the Application.OnKey() method. 
 

Call hierarchy 

 
View 'calls of' and 'calls from' the procedure or Property at the cursor. Once the lists of 'calls of' and 'calls from' are shown, you 
can drill-down into further levels of 'calls of' and 'calls from' allowing you to navigate all calls to and from a selected procedure 
or Property. 
 
Note that: 

• The 'calls' are static design-time calls … this function does not provide a view of the run-time call stack 

• The previously viewed 'call' will be shown in bold … use the 'Back' button to quickly go back to this 'call' 

• If any 1 or more calls are recursive then the "Recursive" column will be shown indicating which calls are recursive 

• While Call hierarchy is multi-Project, it works for only 1 generation of Project parent/child relationship either way: 
o It will find calls of the initial procedure or Property (that Call hierarchy is shown for) in parent Projects but if you 

then jump to a procedure or Property in a parent Project then it will not find calls of that procedure or Property in 
its parent Projects (i.e. to grand-parent Projects of the initial Project) 

o It will find calls from the initial procedure or Property (that Call hierarchy is shown for) to child Projects but if you 
then jump to a procedure or Property in a child Project then it will not find calls from that procedure or Property to 
its child Projects (i.e. to grand-child Projects of the initial Project) 

 

Insert '@EntryPoint' 
 
Supports the functionality of the Orphan declarations functions and the Declarations that could be made Private function. To 
prevent a Procedure from being incorrectly flagged as being an orphan or one that could be made Private, right-click anywhere 
within that Procedure to insert the '@EntryPoint' text. This text must be inserted between the Procedure's body line and the 
'End' line. 
 



 
 
Add Enum from Type Library 
 
Replicate an Enum from a Type Library into your VBA code. Handy if you develop code with early binding but will release your 
code with (or otherwise will subsequently change to using) late binding. 
 
For example, if you are automating Outlook from another host application and you struggle to remember which OlItemType 
refers to which type of Item then use 'Add Enum from Type Library', select the 'Outlook' Type Library then select the 
'OlItemType' Enum and this will be added to your VBA code … 
 
Enum OlItemType 

    olMailItem = 0 

    olAppointmentItem = 1 

    olContactItem = 2 

    olTaskItem = 3 

    olJournalItem = 4 

    olNoteItem = 5 

    olPostItem = 6 

    olDistributionListItem = 7 

    olMobileItemSMS = 11 

    olMobileItemMMS = 12 

End Enum 

 

Add a "GetEnumAsString()" Function 

 
If you define a variable (or other declaration) as having the value type of an Enum and then want to get the value (i.e. the Enum 
member) that has been assigned to it, you will just get the numerical value – there is no simple way to get the name of the Enum 
member. In other words, if you have this Enum … 
 
Enum Fruit 

    FRUIT_APPLE 

    FRUIT_ORANGE 

    FRUIT_PEAR 

End Enum 

 
… and then run this code … 
 
Dim f As Fruit 

f = FRUIT_ORANGE 

Debug.Print f 

 
… then "1" will be sent to the Immediate window (as the default Enum member numbering is 0-based) which isn't ideal unless 
you can remember the exact order of each Enum member. What if you wanted the actual name of the Enum member assigned 
to the variable (i.e. "FRUIT_ORANGE" in this case)? You would need something like this: 
 
Function GetFruitAsString(value As Fruit) As String 

    Dim res As String 

    Select Case value 

        Case Fruit.FRUIT_APPLE: res = "FRUIT_APPLE" 

        Case Fruit.FRUIT_ORANGE: res = "FRUIT_ORANGE" 

        Case Fruit.FRUIT_PEAR: res = "FRUIT_PEAR" 

        Case Else: res = "<Unknown>" 

    End Select 

    GetFruitAsString = res 

End Function 

 
… and then change the Debug.Print line to … 
 
Debug.Print GetFruitAsString(f) 
 
… then "FRUIT_ORANGE" will be sent to the Immediate window which is much clearer as to its meaning. As typing out the 
equivalent of GetFruitAsString() is time consuming, then use the 'Add a "GetEnumAsString()" Function' to add it for you. 
 
The 'Add a "GetEnumAsString()" Function' works not only for Enums defined in your VBA code but also for Enums defined in 
Type Libraries that, either, the VBA Project has a Project Reference to or that are 'referenced' using Special binding.  
 
Structure of the GetEnumAsString() Function 
 
Some Enums are designed so that multiple Enum members can be combined (sometimes called 'composite' Enums). An example 
is VbFileAttribute which can combine a series of file attributes that can be applied to a file, for example a file can be both 



 
 
vbReadOnly and vbHidden. Such Enums have members with values that are 'bit flags' i.e. they are all powers of 2 (optionally 
with an Enum member with a value of 0 … in the case of VbFileAttribute, that is vbNormal). 
 
The 'Add a "GetEnumAsString()" Function' recognises the 'composite' nature of the Enum and adds a Function with a different 
structure so that all Enum members (that are passed into the 'value' parameter) are returned.  
 
An example of an Enum that is not 'composite' is VbDayOfWeek (its Enum members have sequential values, from 0 to 7) for 
which 'Add a "GetEnumAsString()" Function' will add: 
 
Function GetVbDayOfWeekAsString(value As VbDayOfWeek) As String 

    Dim res As String 

    Select Case value 

        Case VbDayOfWeek.vbUseSystemDayOfWeek: res = "vbUseSystemDayOfWeek" ' 0 

        Case VbDayOfWeek.vbSunday: res = "vbSunday" ' 1 

        Case VbDayOfWeek.vbMonday: res = "vbMonday" ' 2 

        Case VbDayOfWeek.vbTuesday: res = "vbTuesday" ' 3 

        Case VbDayOfWeek.vbWednesday: res = "vbWednesday" ' 4 

        Case VbDayOfWeek.vbThursday: res = "vbThursday" ' 5 

        Case VbDayOfWeek.vbFriday: res = "vbFriday" ' 6 

        Case VbDayOfWeek.vbSaturday: res = "vbSaturday" ' 7 

        Case Else: res = "<Unknown>" 

    End Select 

    GetVbDayOfWeekAsString = res 

End Function 

 
… and the returned String will be the name of the one Enum member that is assigned to your variable and passed in as the 
'value' parameter. 
 
An example of an Enum that is 'composite' is VbFileAttribute (its Enum members all have values that are powers of 2, plus one 
that has a value of 0) for which 'Add a "GetEnumAsString()" Function' will add: 
 
Function GetVbFileAttributeAsString(value As VbFileAttribute) As String 

    Dim res As String 

    If (value And VbFileAttribute.vbReadOnly) Then res = res & "vbReadOnly + " ' 1 

    If (value And VbFileAttribute.vbHidden) Then res = res & "vbHidden + " ' 2 

    If (value And VbFileAttribute.vbSystem) Then res = res & "vbSystem + " ' 4 

    If (value And VbFileAttribute.vbVolume) Then res = res & "vbVolume + " ' 8 

    If (value And VbFileAttribute.vbDirectory) Then res = res & "vbDirectory + " ' 16 

    If (value And VbFileAttribute.vbArchive) Then res = res & "vbArchive + " ' 32 

    If (value And VbFileAttribute.vbAlias) Then res = res & "vbAlias + " ' 64 

    If Len(res) = 0 Then 

        res = "vbNormal" 

    Else 

        res = Left$(res, Len(res) - 3) 

    End If 

    GetVbFileAttributeAsString = res 

End Function 

 
… and the returned String will be the names of all of the Enum members that are assigned to your variable and passed in as the 
'value' parameter. 
 
Note that: 
 

• An Enum will be identified as being 'composite' if it includes 3 or more Enum members with non-0 values that are all powers 
of 2 and no Enum members with values that are not powers of 2 (or are not 0). 

• Some Enums are 'partially composite', for example VbVarType has values that are mostly sequential (e.g. vbEmpty which is 
0, vbLong which is 3, and vbByte which is 17) but then has a 'composite' Enum member (which has a value that is a power of 
2), being vbArray which is 8192. VBE_Extras will identify this (and other similar Enums that contain any value that is not a 
power of 2) as being 'not composite' and will add a Function with the structure of the first of the above two examples. 

• For Enums defined in VBA code, when working out whether the Enum is 'composite' or not, the value assigned to the Enum 
member will not (if it is an expression) be evaluated … only Enums for which all members are assigned an explicit numeric 
value will be considered as being possibly 'composite' 

 
Using the Enum members name or value 
 
When adding a Function, whether the Enum members names or values are used (in the Case or If statement, as appropriate for 
whither the Enum is 'composite' or not) depends on whether the source of the Enum is: 
 

• A Type Library: 



 
 

o If the VBA Project has a Project Reference to the relevant Type Library, you will be given the choice of using the 
Enum member names or the Enum member values (the latter being better if you may subsequently revert to using 
late binding for the relevant Type Library) 

o If the VBA Project does not have a Project Reference to the Type Library (e.g. if you are using Special binding), the 
Enum member values will always be used 

• Your VBA Project: 
o The Enum member names are always used 

 
When the Enum member names are used, whether they are prefixed with the Enum name † is defined by the 'Auto Text uses 
qualified names' setting (in the 'Other' tab of the Settings). For example, this is a line from the Function that uses the Enum 
member names prefixed with the Enum name: 
 
Case VbDayOfWeek.vbSunday: res = "vbSunday" ' 1 

 
This is the same line but using the Enum member name alone: 
 
Case vbSunday: res = "vbSunday" ' 1 

 
And this is the same line but using the Enum member value: 
 
Case 1: res = "vbSunday" 

 
Other info 
 
The name of the Function that is added to the code is determined by the name of the Enum ... it is always GetXxxAsString() 
where Xxx is the name of the Enum. If an existing Function with that names already exists then it will be updated (so if the Enum 
is one that is defined in your VBA code and if you update it e.g. adding, removing, re-ordering or otherwise changing Enum 
members) then you can just do 'Add a "GetEnumAsString()" Function' again to update the existing Function to match the 
updated Enum. 
 
The name of the Function's parameter (by default, it is 'value') is defined by the 'Default new parameter name' setting (in the 
'Code' tab of the Settings). 
 
The scope of the Function (whether it is Private, Public or default … an Enum cannot have Friend scope) will match that of the 
Enum itself if the Enum is defined in VBA code, or will have default scope if the Enum is defined in a Type Library. 
 
The number of blank lines added before and after the Function is determined by the 'Blank lines between members' setting (in 
the 'Code' tab of the Settings). 
 
The code of the Function added by 'Add a "GetEnumAsString()" Function' assumes that you will not pass "invalid" values into the 
Function. If you do, you may get equally "invalid" results! 
 
† some Enums in some Type Libraries use an 'Alias' for their name ... Enum members cannot be prefixed with such 'aliased' 
Enum names (they are not recognised by the VBE and will result in compile-time errors) and so the name of the Library itself is 
used in the GetEnumAsString() Function. Examples of 'aliased' Enums (these from Microsoft Scripting Runtime) are 
DriveTypeConst, FileAttribute, SpecialFolderConst and StandardStreamTypes (but other Enums in the same Type Library are not 
'aliased': CompareMethod, IOMode and Tristate). For anyone reading this that is interested (!), you can see the actual name 'in 
plain view': 

• In your VBA Project, add a Project Reference to the Microsoft Scripting Runtime, then 

• Switch on 'show hidden members', and  

• Within a procedure or property, type Scripting (which is the 'program name' for the Microsoft Scripting Runtime) then '.' 
and then, in the VBE's Intellisense popup, scroll down to see the names of the members between 'IOMode' and 'Normal' ...  

• The names such as "__MIDL___MIDL_itf_scrrun_0000_0000_0001" are the actual Enum names … and these names are legal 
code when surrounded with square brackets which the VBE will add for you … 

• To show that these are the actual names (and are legal code), if you select one in the Intellisense popup to add it to your 
VBA code and then, after it, type another '.' you will see the Enum member names listed 

 

Show / hide hidden members 
 



 
 
Exactly the same as clicking the same menu options in the Object Browser window … just that you don't know have to show the 
Object Browser. You can also show hidden members automatically when the VBE starts using the relevant item in the Other tab 
of the Settings. 
 

Project stats 
 
Provides details for each Module in the active Project, including number of declaration lines, number of code lines, number of 
comment lines, number of Procedures and Properties 
 

View 
 

Previous Lists for this Project 
 
Default keyboard shortcut is Ctrl + L (to show the most recent 'previous list') 
 
Allows previously-shown dialogs with lists of declarations, references, literal values, tasks and calls to be immediately re-shown. 
This function is 'single-Project' in that the Previous Lists are available per-Project … if you activate a different Project then the 
Previous Lists shown when that Project was active will be shown.  
 
All information shown is 'as it was' when the original list was shown e.g. the numbers of declarations, references, literal values, 
tasks and calls and their locations (line / column numbers) are not updated if code has been edited since the list was originally 
shown … the idea is that this is a quick way of re-showing a specific list and so is useful when generating a list can take some 
time. As such, some functionality is limited, for example selecting 'Go to' will go to the right location if it is available or will go to 
the nearest possible location otherwise (e.g. if lines have been deleted from or added to a Module). 
 
Previous lists are stored per-Project. If you navigate to a different Project, the previous lists available to be shown will be those 
for that Project. Lists are not deleted when you navigate away from a Project, so you can navigate back to a Project and to see 
the previous lists for that Project. However, previous lists are deleted when a Project is closed or if it is saved with a different 
filename or in a different folder. 
 
There is a maximum number of each type of list that is stored. When this maximum is exceeded then the oldest lists will be 
automatically deleted. 
 
Specific previous lists will be automatically deleted if they become 'invalid' for example if a Module is deleted from your Project 
and that list included an item that was in that Module or referred to that Module. 
 

FullScreen 
 
Default keyboard shortcut is Alt + Shift + Enter 
 
Toggle 'FullScreen' on or off – this hides (when going into FullScreen) / shows (when leaving FullScreen) the 'dockable' windows 
(Project, Properties, Immediate, Locals, Watches and Object Browser) to leave the (one, if you have multiple displayed e.g. 'tiled' 
or 'cascaded') active Code window or UserForm designer window in FullScreen (menus and toolbars are still visible). You can 
choose to not hide some (but not all) of the dockable windows in the Settings. 
 
When you select FullScreen: if any of the dockable windows (other than those you may have chosen to 'not hide') are not 
showing then the VBE is considered to be in FullScreen mode and all dockable windows will be shown; if all dockable windows 
are showing then the VBE will go into FullScreen mode. 
 
FullScreen mode being on or off is per-application (if you have multiple instances of the VBE open). Selecting which of the 
dockable windows are hidden in FullScreen mode is across all VBE-hosting applications but will only take effect in another 
application's VBE when that applications is re-started. 
 
Note that whether a 'dockable' window is currently set to dock or not is set in the VBE Options (Tools > Options > Docking). 
 

Themes 

 



 
 
The Themes dialog is an improved version of the 'Editor Format' tab of the VBE's built-in 'Options' dialog. The Themes dialog 
allows you to choose the same colours (text, background and 'indicators'), font name, font size and presence of the 'margin 
indicator bar' (MIB), but in a much more logical and user-friendly manner. 
 
For example, the Themes dialog:  

• Only allows you to select a colour when that resulting colour can actually 
be shown (for example, the built-in Options dialog allows you to select a 
foreground, i.e. text, colour for a Bookmark when a bookmark is only ever 
indicated by an indicator in the MIB; the Options dialog allows you to 
select an indicator colour for Keyword text when Keyword text does not 
have an indicator) 

• Allows you to select one colour as the background colour for all of the 
'main' text types … if 'Align backgrounds' is selected then the background 
colour chosen for 'Normal' text will also act as the background colour for 
text that is for Syntax errors, comments, keywords and identifiers 

• Includes a sample code image (see image to the right) with a greater 
variety of text-types allowing you to see immediately the result of the 
colour and font changes you have made (the word 'Print' in the image is 
the colours used when text is selected) 

• Has a font name drop-down that shows fonts in that font 

• Allows you to save your colour, font and MIB visibility selections as 
'Themes' … and you can create as many Themes as you want … meaning 
you can switch between entire Themes with a few keystrokes / mouse 
clicks 

 
As with the Options dialog: 

• The colours and font apply only to the main code window and to the 
Immediate window, if visible … the MIB visibility applies only to the main 
code window 

• The colours, font and MIB visibility that you select for the VBE in any one 
host application will also apply to VBE's in any other host application … 
but, if that/those other VBE(s) are already opened, it will only apply once 
you close and re-open the other VBE(s) and host application(s) … see 
below for details as to why 

 
Technical stuff – read only if you're interested or if the Themes dialog isn't doing what you might think it should! 
 

• Themes are applied to the VBE by automating the Options dialog (you will see this in action when you apply a Theme) ... if 
you move focus to another window while a Theme is being applied, you will find the Theme is not applied fully 

• When you add a new Theme based on the 'current settings', the current settings are also read by automating the Options 
dialog ... again, if you move focus to another window while the current settings are being read, you will find the Theme 
shown in the Theme dialog is not entirely correct 

• Ultimately, the colour, font and MIB visibility are stored in the Registry. You may wonder why VBE_Extras bothers with 
automating the Options dialog instead of just updating the values held in the relevant Registry … the main reasons are:  

o The VBE only reads colour, font and MIB visibility from the Registry when the VBE is first loading so changing the 
values in the Registry would make no difference while the VBE is running … you would have to close and re-open 
the host application for the changes to take effect 

o In VBE 7.1 (32 and 64 bit … and perhaps in earlier versions), the VBE fails to save colours for the indicators … it 
simply doesn't create the relevant Registry key so any custom colours you choose for indicators will be honoured 
only while the VBE / host application is running (you can test this by choosing custom colours, closing and then re-
opening the VBE and the host application: you will find the indicator colours have returned to their defaults). 
VBE_Extras resolves this for you, when you apply changes as a Theme, by creating the relevant Registry key 

• For the reason above (the VBE only reads colour, font and MIB visibility from the Registry keys when the VBE is first 
loading), if you change the Theme in the VBE for one host app, it won't change the Theme in any other open VBEs in other 
host applications unless you close and re-open both that other VBE and its host application 

 
Interaction with VBE_Colours 
 



 
 
VBE_Colours is a separate application (available on the https://www.thevbahelp.com/vbe-colours website) that allows you to 
select custom colours to be displayed in the VBE. Unlike the Themes function of VBE_Extras (which allows you to select from the 
built-in VBE colours), VBE_Colours actually allows you to select different colours. 
 
Those custom colours always be honoured in the main code window and in the Immediate window when applied as a Theme by 
VBE_Extras so long as you are using VBE7.1 (that is Office 2013+), 32 or 64 bit. 
 
If you have installed VBE_Colours, Theme "(VBE_Colours custom)" will be shown automatically in the relevant Themes dialogs ... 
applying this Theme acts the same as setting the registry values to 'custom' from within VBE_Colours. 
 
If you are thinking 'custom colours'??!! Yes, it is possible. VBE_Colours will allow you to change the actual colours … that is, not 
select from the pre-existing 16 colours that the VBE makes available, you can actually select different colours. See the 
information at the VBE_Colours link, above, for more info. 
 

Help 
 

Help 

 
Access the latest version of this VBE_Extras guide. 
 

Check for update 
 
Manually check whether there is an updated version of VBE_Extras. VBE_Extras will also do this periodically in the background. 
 

What's new 
 
Show what is new in VBE_Extras … the same as Appendix 2 – Update history 
 

Contact us 

 
Actually, contact me … VBE_Extras was developed by me alone, so please be kind if you do contact me about anything as 
VBE_Extras was created in my spare time! Use this option to: 

• Report a bug 

• Request a feature 

• Ask a question 
 

Licence 
 
Includes options to: 

• Buy a licence for VBE_Extras (via the website) 

• Activate a licence (i.e. once you have bought a licence) 

• Remove a licence that you have previously activated 
 
Note that VBE_Extras comes with a free trial period – you do not have to buy a licence immediately. Additionally, some 
VBE_Extras functions are "free" (you can continue to use them beyond the end of the trial period without purchasing a licence … 
see https://www.thevbahelp.com/vbe-extras for details). 
 

Settings (Backup/save, Restore/load, To defaults) 
 
Backup settings, restore settings, and reset settings to default. The following categories of settings are included: 

• Settings on the 'Task Items', 'Rename', 'Shortcut Keys', 'Code' and 'Highlighting' tabs of the Settings dialog 

• The majority of the settings on the 'Other' tab of the Settings dialog (but not all of them e.g. not the backup folder ... if you 
transferred your settings to a new device then that folder may not exist) 

• Themes 

• The majority of the options selected on the various other dialogs that can be shown by VBE_Extras (e.g. the dialogs that 
show lists of declarations, lists of references, the rename dialog etc) 

 

https://www.thevbahelp.com/vbe-colours
https://www.thevbahelp.com/vbe-extras


 
 

Conditional Compilation Arguments 
 
For more on conditional compilation generally, see Conditional compilation 
 
The Project needs to have been saved at least once for the 'Conditional Compilation Arguments' functions to work. Note that the 
'Conditional Compilation Arguments' functions are multi-Project in that CCAs for multiple Projects can be stored simultaneously 
by VBE_Extras and they will be used only when parsing the relevant Project. 
 

Update CCAs for this Project automatically 

 
VBE_Extras will read in the Conditional Compilation Arguments from the Project Properties window for the active Project and 
apply those to future actions (such as finding declarations and references). If you change the CCAs and want VBE_Extras to be 
'aware' of the new CCAs, you must call this option (or Update CCAs for this Project manually) again. 
 

Update CCAs for this Project manually 
 
You can enter the CCAs for the active Project manually e.g. if you want to use different values than those in the Project 
Properties window or if the option to Update CCAs for this Project automatically fails for any reason. 
 

Clear CCAs for this Project 

 
Clear the CCAs for this Project. 
 

Backup this Project 
 
Create a backup copy of the active Project in your chosen backup folder … the location of the folder, and whether a 'description' 
is included, can be changed in the 'App' tab of the Settings. 
 
The Project needs to have been saved at least once for the 'Backup this Project' function to work. 
 

Settings 
 
Change settings for VBE_Extras. Settings for: 

• Task Items (see Tasks) 

• Rename (see Rename code at cursor) 

• Projects (see Referenced VBA Projects) 

• Shortcut Keys (redefine which keyboard shortcuts operate which VBE_Extras functions) 

• Run (see Sub to run and Immediate window) 

• Code (see various of the functions in Refactor) 

• Indent/Split (see Indent lines and Split line(s)) 

• FullScreen (see FullScreen) 

• Highlighting (see Highlight) 

• Version Control (see Version Control) 

• Other - which includes settings for: 
o Reference order (see References for code at cursor) 
o Whether to match conditional compilation directives (see Conditional compilation) 
o The Project and Module Pickers (see Project Picker / Module Picker) 
o Whether mouse-click functions are enabled (see Mouse-click functions) 
o Orphans (see Orphan declarations) 
o Option Explicit (see Option Explicit) 
o AutoText (see AutoText) 
o Names (see Go to Name with this name) 
o Hidden members (see Show / hide hidden members) 
o VB_PredeclaredId and VB_Exposed (see Go to Module) 

• Experimental (enable or disable 'experimental' functions) 

• App – which includes settings for: 
o Allowing VBE_Extras to automatically check for updates 



 
 

o Logs - set the logging level, view the logs 
o Other tools to support debugging 
o Changing the main menu 'x' accelerator key (see Appendix 4 – changing the main menu's 'x' accelerator key) 
o Backup folder (see Backup this Project) 

 
See also Settings (Backup/save, Restore/load, To defaults) 
 

About VBE_Extras 
 
Information about VBE_Extras and the environment it is running in on your device. 
 

Functions not available in the main menu 
 
Some of these functions are also available in other menus (though not in the main menu), in the Toolbar and/or using shortcut 
keys. 
 

References of this Project 
 
Available in the Project window context menu (when the Project name is clicked). 
 
Same as References for code at cursor but for the Project clicked in the Project window. 
 

References of this Module 
 
Available in the Project window context menu (when an individual Module name is clicked). 
 
Same as References for code at cursor but for the Module (document, standard, Class or UserForm) clicked in the Project 
window. 
 

View as text file 
 
Available in the Project window context menu (when an individual Module name is clicked). 
 
For a Module, create and display a text file with a single click. 
 

Compare Project 
 
Available in the Project window context menu (when the Project name is clicked). 
 
View a report of the differences between the current version of a Project (in the VBE) and a previously exported Project (for 
example, a Project exported using Version Control). The 'diff report' shows: 
 

• Which Modules have been added, deleted or updated, and from that you can drill down to: 
o For added or deleted Modules, view the code of the Module 
o For updated Modules, view a report of the differences at the 'member' level (view added, deleted or updated 

members) … again you can drill down to: 
▪ For added or deleted members, view the code of the member 
▪ For updated members, view a 'line-by-line' diff report highlighting which lines have been updated (case-only 

updates are highlighted yellow; 'material' updates are highlighted green) … optionally show or hide differences due 
to line numbers and/or whitespace (only whitespace at the start / end of a line) using the options in the View 
button's drop-down menu 

• If an export was created using VBE_Extras version 1.4.6.0 or greater, which Project References have been added or deleted 

• If an export was created using VBE_Extras version 1.4.7.0 or greater and if the 'RibbonX – export / compare-on-import' 
setting was checked at the time of the export, which RibbonX 'customUI' XML file(s) have been added, deleted or updated, 
and from that you can drill down to: 
o For added or deleted 'customUI' XML files, view the RibbonX 



 
 

o For updated 'customUI' XML files, view a 'line-by-line' diff report highlighting which lines have been updated 
 

Compare Module 
 
Available in the Project window context menu (when an individual Module name is clicked). 
 
View a report of the differences between the current version of a Module (in the VBE) and a previously exported version of the 
same Module. The 'diff report' shows which Module members † have been added, deleted, updated, renamed and from that 
you can drill down to: 
 

• For added or deleted members, view the code of the member 

• For updated members, view a 'line-by-line' diff report highlighting which lines have been updated (case-only updates are 
highlighted yellow; 'material' updates are highlighted green) … optionally show or hide differences due to line numbers 
and/or whitespace (only whitespace at the start / end of a line) using the options in the View button's drop-down menu 

 
† breakdown of 'Module members' is by individual procedure and property plus as groups of lines: all declaration lines; all 
Module-level Attributes; for Access Forms and Reports, all 'control and UI layout' lines 
 

Version Control 
 
Available in the Project window context menu (when an individual Module name is clicked, menu items for importing / 
exporting an individual Module will be shown; when the Project name is clicked, menu items for importing / exporting the entire 
Project will be shown). 
 
Version Control supports the export and subsequent import of one Module or all Modules in a Project. Additionally, when the 
export or import is for a Project (not an individual Module) then Project References and RibbonX can be included (see the 
'Scope' section within the 'Other Version Control related information' section, below, for further information). 
 
Settings for Version Control are available in the ‘Version Control’ tab in the Settings. 
 
Version Control comes in two ‘types’ – Plain and Full 
 

• Plain - exports the Module or Modules to a specific folder. When you perform an export, any existing export files in the 
same folder will be deleted†. Use this option if using a Version Control system e.g. Git (but note that VBE_Extras' Version 
Control does not integrate directly with Git or any other version control tool). 

• Full - exports the Module or Modules plus an XML file to a 'timestamped' folder so creating a new folder for each export. 
Use this option if you want to export / import on your local device and / or want to have multiple exports available. The 
XML file will include the date/time of the export and, optionally, a ‘reason’ (that you specify during the export process) and 
your username. When performing an import, this information will be shown to you to aid in selecting the correct export to 
be imported. 

 
† other than UserForm .frx files if the ‘Export UserForm .frx files’ setting is ‘Ask’ and you turn down the export of them … see 
section ‘Relevant to host applications that support UserForms’ below for more info. 
 
Version Control allows export / import to and from one of 3 specific locations 
 

• Project folder - always exports to and imports from the same folder that the VBA Project (e.g. the Excel Workbook, the 
Access Database etc) is in. 

• Project sub-folder - always exports to and imports from a sub-folder of the of the folder that the VBA Project (e.g. the Excel 
Workbook, the Access Database etc) is in - that folder will be named the same as the Excel Workbook, the Access Database 
etc. 

• Specific folder - always exports to the same folder for all VBA Projects but allows you to set (and change) that folder each 
time you perform an export or import. 

 
If using the Full type of Version Control, you can also select to import from sub-folders of the Project folder / Project sub-folder / 
Specific folder. 
 



 
 
In Outlook, "the same folder that the VBA Project is in" means the location of the VBAProject.OTM file. Typically, this is 
somewhere like: "C:\Users\yourusername\AppData\Roaming\Microsoft\Outlook". For more, see 
https://learn.microsoft.com/en-us/outlook/troubleshoot/deployment/manage-distribute-outlook-vba-project. 
 
When importing a Module 
 
You have two options: 
 

• ‘Import this Module’ … allows you to select, and import, a previously exported version of the same Module … before the 
import takes place, you will always be shown a report of the differences between the current and the previously exported 
version of the same Module (see Compare Module for details) 

• ‘Import new Module’ … allows you to select, and import, a previously exported Module that is now no longer in the active 
Project … before the import takes place, you will always be shown the text of the previously exported Module  

 
For both options, you can select the version of the Module to import from any previous exports of just this one Module and 
from any previous exports of the entire Project that included this Module. 
 
When importing a Project 
 
You have two options: 
 

• ‘Import Project (add and update Modules)’ … as it says, only adds Modules that are include in the export but are not in the 
active Project plus updates Modules that are included in the export but are different in the active Project 

• ‘Import Project (replace Modules)’ … as well as doing the same as in the above bullet, if a Module is not in the export but is 
in the active Project then it will remove that Module from the active Project 

 
Whichever of these two options you use, you will always be shown a report of the differences between the export and the active 
Project so that you can make a final decision as to whether to import or not. The 'diff report' is initially shown at the Project level 
showing the Modules that will be added, deleted or updated and from that you can drill down into the Module level showing the 
Module-members that will be added, deleted, updated or renamed (see Compare Project for details of the 'diff report'). 
 
Other Version Control related information 
 
Scope 
 
The scope of what is exported and imported is as follows: 
 

• In host applications other than Access: 
o VBA code … in all types of Modules 
o VBA attributes … in Standard, Class and UserForm Modules 
o UI elements in UserForms 
o Project References † are exported and (optionally) imported ONLY WHEN exporting / importing the entire Project 

(not when exporting / importing a single Module) 
o RibbonX 'customUI' file(s) are (optionally) exported and compared-on-import ‡ ONLY WHEN exporting / importing 

the entire Project (not when exporting / importing a single Module) - not in Outlook or Access 

• In Access, in addition to the above: 
o UI elements in Forms and Reports 
o VBA attributes in Forms and Reports 

 
† Project References (sometimes called External References) are the References that a VBA Project holds to external Type 
Libraries, other VBA Projects, and Templates (e.g. in Word) … these can be seen in the VBE's 'References' dialog available via 
Tools > References or in VBE_Extras's Update Project References dialog. 
 
‡ RibbonX 'customUI' file(s) cannot be imported but will be included in the 'report of differences' if any differences are found 
 
Relevant to host applications that support UserForms 
 
UserForms are exported as two files (in the same way that they are if you export a UserForm directly using the VBE) … both an 
.frm file (for the code and Attributes) and an .frx file (for the UI elements). Due to the way that the VBE itself creates the .frx 

https://learn.microsoft.com/en-us/outlook/troubleshoot/deployment/manage-distribute-outlook-vba-project


 
 
files, the .frx file will be different every time that an export is done (again, in the same way that it would be if you export the 
UserForm directly using the VBE). 
 
As such, when importing a UserForm Module (or a Project that includes one or more UserForms) then the ‘diff report’ will 
always indicate that the UserForm has been updated (whether it has or not). This is particularly problematic when using the 
Plain type of Version Control combined with Git – as such, the ‘Export UserForm .frx files’ setting allows you to either always 
export .frx files or ask before exporting .frx files. 
 
Document Modules in host applications other than Access 
 
Document Modules cannot actually be imported (the VBE does not allow it as they are controlled from the host application’s 
user interface, not from the VBE). For example, in Excel, Worksheets cannot be added or removed during an import. 
 
As such, an import can only replace the code in the existing Document Module(s) with the code from the exported version. User 
interface elements cannot be imported, neither can Properties (as seen in the VBE's Properties Window) and neither can 
Attributes. 
 
As Outlook and Word can only have 1 Document Module then the adding and removing of Document Modules is less of an issue 
(in Outlook, 'ThisOutlookSession' cannot be renamed; in Word, 'ThisDocument' can be renamed and so it is possible for Version 
Control to indicate a change of Document Module … but I strongly recommend you do not rename it). 
 
Access-specific 
 
Forms and Report can be exported and imported … including the user interface elements, their Properties and their Attributes. 
Behind-the-scenes, Access's built-in (but hidden) SaveAsText and LoadFromText procedures are used. 
 
Occasionally, in Access, an import can take a number of seconds if Reports are included in the import and if Access decides it 
needs to get a printer connection (you may see a " Waiting for printer connection ..." dialog). Please be patient as VBE_Extras 
needs to wait for Access to finish before it can complete the import. 
 
The Module or Modules being exported must not include characters that are not allowed in Windows filenames (Access can 
include such characters in Module names). You will not be able to do an export (and a dialog will be shown explaining the 
problem) if this is the case. 
 
Case-only Module changes 
 
It is possible for a Module to be changed without any direct editing of the code. For example, if multiple Modules include 
separate declarations with the same name, changing the case of one will change the case of the other (due to the VBE's case 
agnostic / case consistency rules). For example, if you add a Sub "Foo" in Module1 and add a Sub "Foo" in Module2 and then 
change the name in Module1 to "FOO" then the name will also change in Module2. 
 
This means that if you import a previously exported Project, the 'diff report' may indicate that some Modules have changed 
when you believe they have not … it is the VBE itself that has changed the casing. When this is identified, the 'diff report' will 
identify the 'changed' Modules as being "case only" changes and you will be given an option to import, or not, the Modules with 
case-only changes. 
 
Conversely, if you perform an import but choose not to import Modules with "case only" changes, those changes to the case 
may still be made (by the VBE itself, not directly by the import) … for example, in a Project with two Modules, 'Module1' and 
'Module2': 

• If 'Module1' includes a material (i.e. not just a change to the case) change and it includes a declaration for which only the 
case has changed; and  

• If 'Module2' includes a reference to the declaration in 'Module1' for which the case has changed and it includes no other 
material changes  

• … then: if you perform an import that excludes "case only" changes (i.e. it includes 'Module1' but excludes 'Module2') then, 
once 'Module1' is imported, the VBE will change the case of the reference in 'Module2' to match the case of the declaration 
in 'Module1' (again, due to the VBE's case agnostic / case consistency rules) 

 
Other info 
 



 
 
For all except Access Forms and Reports, the name of the imported Module is controlled by the VB_Name Attribute, not the 
filename. For Access Forms and Reports, the name is controlled by the filename which must start with "Form_" or "Report_" 
respectively. 
 
Document Modules are exported with 'custom' file extensions so that their type can be determined before the file contents are 
read: 

• In all applications other than Access, a ".dcm" file extension is used instead of the typical ".cls" 

• In Access, a ".afm" extension is used for Forms and a ".art" extension is used for Reports instead of the typical ".txt" 
 
The VBE has a habit of inserting lines at the end of all Modules and at the start of UserForm code Modules when exporting / 
importing. As such, whitespace before the first line of code and after the last line of code is ignored. 
 

Replace All Modules in this Project 
 
Available in the Project window context menu (when the Project name is clicked). Only available in Excel and Word, in the 
Project window context menu. 
 
Replaces all Modules (and so all VBA code and UserForm designers) in the active Project with that from another (the 'source') 
Project. The active and source Projects must be contained in the same host application. The file (Document / Workbook / 
Template / AddIn) that contains the source Project must be open and both Projects must be unlocked. 
 
The active Project must contain Document Modules with matching names for each of those in the source Project - that is: 

• For Excel: 
o There must be a matching Worksheet with the same name in the active Project for every Worksheet in the source 

Project 
o There must be a matching Chart with the same name in the active Project for every Chart in the source Project, if 

any 
o The name of the ThisWorkbook Module in the active Project must match the name of the ThisWorkbook Module in 

the source Project 

• For Word: 
o The name of the ThisDocument Module in the active Project must match the name of the ThisDocument Module in 

the source Project 
 
The active Project's name will be updated to match that of the source Project. Attributes in standard, Class and UserForm 
Modules will be updated but those in Document Modules will not be. 
 
The active Project's description, Conditional Compilation Args, password and references to other VBA Projects or Libraries are 
not updated. 
 
Note for ActiveX Controls and other objects embedded in Worksheets (Excel) / the Document (Word): the code relating to the 
ActiveX Control (eg Event handlers) will be replaced along with all other code. However, the ActiveX Control itself will not be 
replaced as it exists in the 'UI' and not in a Module. 
 
Background 
 
The main aim of the Replace all Modules function is to resolve the problem whereby VBA code and data reside in the same file 
and users need to continue to use the 'live' file and update the data it contains while at the same time the developer needs to 
update the code. Typically, the data and the code will then be out of sync (i.e. there will be one file with the latest data and 
another with the updated code) and an exercise takes place at some point to copy the new code over to the file with the correct 
data … depending on the number of Modules involved, this can be a laborious and error-prone process. Using the Replace all 
Modules function, this can be completed with a couple of clicks. It should be noted that while this function will copy any 
Modules from one file to another (noting the provisos above) it is really designed to copy an updated version of the same code 
from one file to another. 
 
Before anyone reading this contacts me to say that there is a better solution to the described problem (use an AddIn) … I know, I 
know! However, this function helps anyway: 
1. My experience of being asked to fix or update code developed by others that is already in the same file that the data is in 

drove me to write this function for VBE_Extras. With this function: the customer can send you a version of the file in which 
the data and code reside; the customer can continue to update the data in their version of the file while you spend time 



 
 

updating the code in your version; you agree a time for the code to be implemented; the customer sends you the latest 
version of the file (i.e. with the latest data but with now out-of-date code) and freezes making updates; in seconds you 
update the code in the latest version of the file and get it back to the customer. 

2. Occasionally a customer will not want to share 'actual' data with a developer if, for example, it is commercially sensitive. 
With the Replace all Modules function, the customer can send you a file with dummy data and the real code. You can 
update the code and send the file to the customer. The customer, having installed VBE_Extras and being shown how to 
access the VBE, can then import your code with a couple of clicks. 

 

Clean this Project 
 
Available in the Project window context menu (when the Project name is clicked). 
 
Cleans the 'junk code' that builds-up over time when developing macro-enabled files. This 'junk code' can lead to strange 
problems such as: 

• Projects crashing when you open them * or when you click on 'Enable Content' (in the gold banner in the UI), or when you 
first run the Project's code  

• Compile-time or run-time errors for code that is clearly valid, for example "Invalid outside procedure" for something that is 
clearly within a procedure; "User-defined type not defined" on a VBA reserved-word; "ByRef argument type mismatch" 
when an argument and the parameter are clearly of the same type 

 
* if you find you cannot even open a Project (eg Excel Workbook, Word Document etc) in order to run the 'Clean this Project' 
function as the host app force-closes during the opening process, try to: close the Project; rename the file (to anything 
different); open the file without clicking 'Enable Content'; go to the VBE; in the main VBE menu, select Debug > Compile; save 
then close the Project; rename the file back to the original name; open the file (click 'Enable Content' if it appears), go to the VBE 
… at this point, you may find that any problems you were experiencing have been resolved … but if not, then run the 'Clean this 
Project' function. 
 
How does 'Clean this Project' work? 
 
'Clean this Project' performs a number of steps: 
 

• It performs a full export of all of your VBA code across all Modules of the Project (the same as is done for a Version Control 
'Project export') to a temporary folder 

• It removes all of the Standard, Class, UserForm and, if running in Access, Document Modules from the Project 

• If running in any host app other than Access (as Document Modules cannot be removed from these hosts via the VBE), the 
code of each Document Module is deleted 

• The code is compiled (as there is no code, this effectively deletes all of the previously compiled code including any 'junk 
code') 

• It performs a full import of all of the VBA code that was previously exported (again, the same as is done for a Version 
Control 'Project import') from the temporary folder 

 

View RibbonX 
 
Available in the Project window context menu (when the Project name is clicked) for Excel, Word and PowerPoint. 
 
View the RibbonX (Ribbon XML) file(s) stored within the Workbook / Document / Presentation / AddIn. Note that only certain 
types of file support RibbonX (for example, it cannot be extracted from non-XML files such as .xls or .doc and it cannot be 
extracted from Excel binary files .xlsb). 
 

Update Project References 
 
Available in the Project window context menu (when the Project name is clicked). 
 
This is an equivalent of the VBE's own 'References' dialog (i.e. that you access via Tools > References) with the advantages of: 
 

• You can search/filter by name, filename or GUID for specific Type Libraries and Projects 

• View both Type Libraries and Projects or just one-or-the-other 

• Retains a list of recently added Type Libraries so that you can quickly re-add them (to the same or to a different Project) 



 
 
• Displays the Version and, optionally, the Flags, Language ID, Resource ID and GUID for each Type Library 

• Right-clicking on a Type Library in either the 'Current References' or 'Available References' list: 
o Displays a Type Libraries 'program' name … see 'Why is knowing the 'program' name useful?', below 
o Allows you to copy the name, path or GUID of the Type Library 
o Allows you to copy the 'As <Ref>' code comment for Special binding 
o Allows you to 'explore' the members of the Type Library before (or after) you have added a reference to it … see 

Type Library explorer 
 
Why is knowing the 'program' name useful? 
 
When using early binding, this is the name you use in VBA code to refer to the library which, when followed by a '.', shows the 
names of all of the available 'types' that the library provides in the VBE's Intellisense window. 
 
For example, the 'program' name for the 'Microsoft Scripting Runtime' is 'Scripting' … if you add 'Microsoft Scripting Runtime' as 
a reference and then in VBA code type 'Scripting' followed by a '.', you will see the names of the available 'types' (actually classes 
in this case) that the 'Microsoft Scripting Runtime' library provides. 
 
While the 'program' name is often similar to the library name or filename, it does not have to be - for example, if you didn't 
know from other sources, working out that the 'program' name for the 'Windows Script Host Object Model' library (filename 
'wshom.ocx') is 'IWshRuntimeLibrary' could take you some time (and the VBE provides no simple way to find it … other than 
trawling through thousands of entries in the Intellisense window). 
 

Type Library explorer 
 
Explore the members of a Type Library before (or after) you have added a reference to it. 
 
By default, the members are displayed in a parent / child 'tree view' such that child members only appear within their parent. 
However, this is not how the VBE displays members of Modules or Enumerations … the VBE shows them in a 'flat hierarchy' as 
though they were also 'top level' members. If you prefer the VBE 'flat hierarchy' then you can enable this in the 'Code' tab of the 
Settings. 
 
Hidden members of the Type Library are shown if you have 'hidden members' being shown … see Show / hide hidden members 
for more. 
 

Rename Control 
 
Available in the UserForm Control window context menu. 
 
Same as Rename code at cursor but for the Control clicked in the UserForm design window. 
 

References for Control 
 
Available in the UserForm Control window context menu. 
 
Same as References for code at cursor but for the Control clicked in the UserForm design window. 
 

History - Back / Forward 
 
Available in the Toolbar (when shown) and by using the Ctrl + - (that is Ctrl and minus) and Ctrl + Shift + - (that is Ctrl and Shift 
and minus) keyboard shortcut.  
 
Allows you to move the cursor back to previously visited code locations. Having moved back, you can then move the cursor 
forward to subsequent locations.  
 
See the 'Note' in Show History about some built-in actions in the VBE not being recorded in the history. 
 

Show History 
 



 
 
Available in the Toolbar (when shown) and by using the Alt + - (that is Alt and minus) keyboard shortcut.  
 
Shows a drop-down of recently visited code locations (most recent at the top). The current location within the history 'stack' is 
shown within '>' and '<'. You can then select an location from the drop-down to move the cursor to that previously / 
subsequently visited location. 
 
Note that some actions in the VBE that move the cursor do not trigger an 'event' and so cannot be recorded in the 'history' (for 
example, using the built-in keyboard shortcut Shift + F2 to go to a declaration … to avoid this problem, always use the 
VBE_Extras equivalent, F12 … see Go to declaration for code at cursor). 
 
If you 'go back' and then carry out an action that causes a new code location to be added to the history then the 'forward' stack 
is removed. 
 

Project Picker / Module Picker 
 
Default keyboard shortcut is Ctrl + 1 / Ctrl + Tab, respectively 
 
These will be familiar (ish) to users of Visual Studio …  
 
The Project Picker shows a dialog listing the Projects loaded in the VBE in the order they were last accessed, or alphabetically for 
those never accessed (Projects that are locked are greyed-out). Very handy for going back-and-forth between the two previously 
active Projects. 
 
The Module Picker shows a dialog listing the Modules (document, standard, Class or UserForm) of the active Project in the order 
they were last accessed, or alphabetically for those never accessed. Very handy for going back-and-forth between the two 
previously active Modules. UserForm 'designers' (highlighted in the Picker) are treated as though they are separate Modules so 
that you can easily navigate between the UserForm code and the UserForm designer. 
 
For either Picker, a single press-and-release of the keyboard shortcut will change the active Project / Module to the previously 
active Project / Module. 
 
Or press the keyboard shortcut then hold down the Ctrl key and use either subsequent presses of the Tab key or the up/down 
arrow keys to move between Projects / Modules … release the Ctrl key when you have selected the Project / Module you want 
to activate. 
 
If the Project Picker is showing, a press of the right arrow key will take you to the Module Picker for the selected Project; if the 
Module Picker is showing, a press of the left arrow key will take you to the Project Picker.  
 
Both the Project and Module Pickers remember the order that Projects / Modules were last accessed (the Module Picker 
remembers the order for each individual Project) so if you were working on one Project, change to another and then come back 
to the original Project, the Module Picker will show the Modules in the correct order. 
 
If required, the Project and Module Pickers can be switched off in the Settings dialog. 
 

AutoText 
 
All AutoText is added by pressing the Tab key when the cursor immediately follows the 'AutoText' text that is to be converted. 
There must be no code (though there can be code-comments) following the cursor position. AutoText will not be added when 
typing comments or literal values. 
 
Options for AutoText, including switching it on or off, are in the 'Other' tab of the Settings dialog. 
 
AutoText using '?' 
 
Within a Procedure / Property … 
 

• A solo question mark - the question mark will be replaced with 'Debug.Print ' (trailing space is intentional) … hold down Shift 
to include 'Now,' 

• A question mark which immediately follows: 



 
 

o The name of one or more in-scope variables, statics, constants, Type elements, Properties or Functions (for 
Property and Function, only where they take no parameters) and which has a 'primitive' value type – the name and 
question mark will be replaced with 'Debug.Print "name = " & name & ""' … hold down Shift to include 'Now,' 

o The name of an in-scope variable that has a type of a Type – you will be prompted to select an element of the Type 
then this will be processed as above 

o The name of an in-scope variable that has a type of a Class – you will be prompted to select a member of the Class 
then this will be processed as above 

o Anything else – AutoText takes a 'user knows best' approach and processes as per above (for example if you type 
Application.Name? then press Tab this will be replaced with Debug.Print "Application.Name = """ & 
Application.Name & """" 

 
AutoText using '=' 
 

• A solo equals sign when in a Function or Property Get – the name of the Function or Property Get will be inserted before the 
equals sign along with 'Set' if the Function or Property Get is returning a non-primitive type 

 
AutoText using '!' 
 
While the following AutoTexts are referred to as those "using '!'", the use of "!" is actually optional, controlled by the 'AutoText 
status' dropdown in the 'Other' tab of the Settings dialog. However, all of the 'From' AutoTexts are shown, in the tables below, 
with the '!' present. 
 
In the following tables: 

• <cond> represents a condition (e.g. in an 'If … Then' statement) 

• <name> represents the name of a variable or other declaration (e.g. in 'With' statement) 

• <num> represents a number 
 
Note that: 

• The 'From' AutoText may only be preceded by whitespace and followed by whitespace and/or code-comments 

• The supplied <cond>, <name> and <num> are not checked by VBE_Extras at the time the AutoText is converted to code 
(other than for Select Case … End Select blocks when the supplied <name> is a variable with a value type of an Enum) but 
will, obviously, be checked by the VBE, at compile-time or at run-time, in the same way as any other code 

• All of the 'From' AutoTexts are case-insensitive 
 
Anywhere in a Module 
 

From To 

#if! / #if <cond> then! An #If Then … #End If block 

#ife! / #ifelse! 
#if <cond> thene! 
#if <cond> thenelse! 

An #If Then … #Else … #End If block 

 
In the declaration lines of a Module 
 

From To 

opm! Option Private Module 

oe! Option Explicit 

ocb! Option Compare Binary 

oct! Option Compare Text 

ocd! Option Compare Database * 

ob0! / ob1! Option Base 0 / Option Base 1 

enum! / enum <name>! An Enum … End Enum block 

type! / type <name>! A Type … End Type block 

 
* = in Access only 
 
Within a Procedure / Property 
 

From To 



 
 

for <name> <num> <num> <num>! A For … Next block 

• The <name> must be specified and is the For loop 'counter' 

• The first two <num> must be specified and are the For loop 'bounds' 

• The third <num> is optional, if specified then it is used as the Step value 

forr <name> <num> <num>! A For … Next block with a Step of -1 

• The <name> must be specified and is the For loop 'counter' 

• The two <num> must be specified and are the For loop 'bounds' 

fora <name> <name> <num>! A For … Next block which iterates over an array from LBound to UBound 

• The first <name> must be specified and is the For loop 'counter' 

• The second <name> must be specified and is the array 

• The <num> is optional, if specified then it is used as the array dimension 

forra <name> <name> <num>! As for a but iterates over an array from UBound to LBound 

fore <name> <name>! 
foreach <name> <name>! 

A For Each … Next block 

• The first <name> must be specified and is the For loop 'element' 

• The second <name> must be specified and is the collection that is being 
iterated over 

with! / with <name>! A With … End With block 

if! / if <cond> then! An If Then … End If block 

ife! / ifelse! 
if <cond> thene! 
if <cond> thenelse! 

An If Then … Else … End If block 

do / do <cond>! 
do loop while! / do loop while <cond>! 
doloopwhile! / doloopwhile <cond>! 
dolw! / dolw <cond>! 

A Do … Loop While block 

do while! / do while <cond>! 
do loop! / do loop <cond>! 
dowhile! / dowhile <cond>! 
dowl! / dowl <cond>! 
dow! / dow <cond>! 

A Do While … Loop block 

do loop until! / do loop until <cond>! 
doloopuntil! / doloopuntil <cond>! 
dolu! / dolu <cond>! 

A Do … Loop Until block 

do until! / do until <cond>! 
dountil! / dountil <cond>! 
doul! / doul <cond>! 
dou! / dou <cond>! 

A Do Until … Loop block 

while! / while <name>! 
wend! / wend <name>! 

A While … Wend block 

select! / select <name>! 
select case! / select case <name>! 

A Select Case … End Select block 

• If <name> is a variable with a value type of an Enum (defined in VBA code or 
defined in a Type Library) then the Select Case … End Select block will 
include a Case line for each Enum member 

• Whether the Case line includes the name of the Enum itself is controlled by 
whether the 'AutoText uses qualified names' checkbox (on the 'Other' tab 
of the Settings dialog) is checked or not. 

 

Toolbar 
 
VBE_Extras includes a Toolbar with a number of buttons. If the Toolbar is not visible then, in the VBE, select View > Toolbars > 
VBE_Extras. 
 
Note that VBE_Extras cannot control the placing of the Toolbar, this is controlled dynamically by the VBE itself. 
 



 
 

Mouse-click functions 
 
Mouse clicks (combined with Ctrl or Alt) on declarations, references and literal values perform specific functions: 
 

 While holding down Ctrl … While holding down Alt … 

… click on a 
declaration 

See a list of all references for that declaration (the 
same as References for code at cursor) allowing 
you to jump to any of those references 

Highlight the on-screen declaration and references 
for a specific declaration (the same as Highlight) 

… click on a 
reference 

Jump to the declaration (the same as Go to 
declaration for code at cursor) 

… click on a 
literal value 

See a list of all matching literal values (the same as 
Matches for literal value at cursor) allowing you to 
jump to any of those values 

n/a 

… click on a 
'word' * 

n/a Highlight the on-screen matches for that 'word' * 
(the same as Highlight) 

 
Note that if the entire declaration name / literal value / 'word' is selected, then you will have to double-click it to perform the 
mouse-click function. 
 
* the 'word' can be a VBA keyword or any other text that is not in a string literal or in a code comment 
 
If desired, the Mouse-click functions can be switched off in the Settings dialog. 
 

VBE_Extras Helper 
 
Available in Excel only.  
 
VBE_Extras Helper is an Excel AddIn that supports working with Shapes, Tables and Names in the Excel UI. VBE_Extras Helper 
must be installed separately from VBE_Extras itself.  
 
When using VBE_Extras Helper, if you receive a message "For this function to work, VBE_Extras must be installed and loaded in 
the VBE" then either: 

• VBE_Extras is not installed at all - see Installation , or 

• VBE_Extras is not loaded in the VBE … to fix, in the VBE main menu (not in the host app's 'ribbon' menu): Add-Ins > Add-In 
Manager … in the list of 'Available Add-Ins' highlight VBE_Extras and put a tick/check in both the 'Loaded/Unloaded' and 
'Load on Startup' checkboxes 

 
The following functions can be accessed in the Excel UI either in the 'Add-ins' tab of the ribbon menu or via the right-click 
context menu for Shapes / Tables: 
 

Shapes 
 

Uses of Shape's name 
 
For the selected Shape, list all String literals matching the Shape's name property in the relevant Workbook or AddIn: 

• First, the VBA Project in the Workbook that the Shape is within is searched 

• Second, if there are no matches for the Shape's name in the VBA Project in the Workbook AND if the active VBA Project is in 
an AddIn, then search within the AddIn 

 
This function is not 'code-context sensitive' ... all matching String literals will be returned: 

• Whether they refer to a Shape name or not, and whether they refer to a Shape in the right Worksheet or Chart sheet or not 

• Matches are not case-sensitive 
 
This function requires the VBE for the host application to have been opened at least once during this session of the host 
application, and for VBE_Extras to be loaded. 



 
 
 
For the reverse action, see Go to Shape with this name or that calls this Procedure. 
 

View / Copy Shape's name 
 
View and copy the selected Shape's Name property. 
 

Go to OnAction 
 
For the selected Shape, go to the procedure that is the target of the Shapes' OnAction property (as set using 'Assign Macro'). 
 
This function requires the VBE for the host application to have been opened at least once during this session of the host 
application, and for VBE_Extras to be loaded. 
 
For the reverse action, see Go to Shape with this name or that calls this Procedure. 
 

View / Copy OnAction 
 
View and copy the selected Shape's OnAction property (as set using 'Assign Macro'). 
 

Tables 
 

Uses of Table's name 
 
The same as Uses of Shape's name but for Tables. 
 
For the reverse action, see Go to Table with this name 
 

View / Copy Table's name 
 
View and copy the selected Tables Name property. 
 

Names 
 

Uses of Name's name 
 
The same as Uses of Shape's name but for Names. 
 
For the reverse action, see Go to Name with this name 
 

View / Copy Name's name 
 
View and copy the selected Name's name property. 
 

Known problems 
 
Following renaming a Class Module that is used as an Interface, when you try to compile the Project, occasionally the VBE will 
show a warning dialog with a message such as "User-defined type not defined" ... the VBE will not jump to a specific line for the 
error (as there is no error). This can be resolved by either: 

• Find the 'Implements' statement in the Class that implements the Interface, change the name of the Interface (to something 
invalid), compile the Project (to create a genuine error), then change the name of the Interface back to what it should be, 
compile again … error cleared 

• Ignore the error and just run the code in your Project … it will run despite the 'error' and the error will be cleared 



 
 
 
VBE_Extras is suddenly missing from the VBE: 

• Check that VBE_Extras is loaded … see Check the AddIn Manager 

• Close the host application. If the host application supports multiple instances of itself running at once, close those as well. 
Then use Task Manager (via Ctrl+Alt+Delete) to check for and kill any hidden ('zombie') instances of the host application. Re-
start the host application and re-open the VBE.  

 

Reporting a problem 
 
If you have VBE_Extras running on your device, please use the Contact us menu option - this will help you to clarify your problem 
report and ensure the right information is provided by you so that I can assist with the problem. If you are reporting a problem 
that relates to specific VBA code, please try to include a Minimal, Reproducible Example (see 
https://stackoverflow.com/help/minimal-reproducible-example) when making contact so that any problem or bug can be 
reproduced. Without being able to reproduce your problem or bug, it is unlikely that a fix can be developed. 
 
If your problem is with getting VBE_Extras to install or run on your device, then please see the Appendix 1 – Installation 
troubleshooting section. 
 

Performance 
 
To improve the performance of VBE_Extras: 

• Save all VBA Projects open in the host application at least once 

• Use more / smaller Modules, not less / larger Modules 

• Use fully qualified references (see Terminology) 

• Use appropriate access modifiers (i.e. don't make everything Public) 

• Ensure that Logging (in the Settings) is not set to Verbose … this can have a very significant impact on performance … it is 
designed to be switched to Verbose briefly while you perform an operation prior to sending a log file to the developer for 
analysis (Verbose will always be switched off initially when you close the last running VBE host application on your device) 

 

Appendix 1 – Installation troubleshooting 
 
Please first ensure you have correctly followed the Installation instructions. Note that VBE_Extras only works on Windows, 
versions from Windows 7 onwards. It also requires .NET Framework 4.8 to be present on your device - .NET Framework 4.8 is 
installed by default on newer versions of Windows 10 (May 2019 onwards) and all versions of Windows 11 – to get the .NET 
Framework 4.8, see If you need to install or check for .NET Framework 4.8. Obviously VBE_Extras also requires Excel, Word, 
Outlook, PowerPoint and/or Access (the 'host applications') to be installed. If your device does not meet these requirements 
then VBE_Extras cannot be installed. 
 
VBE_Extras is installed on a per-user basis. If your device has multiple users then each user will need to separately install 
VBE_Extras. 
 
To test whether VBE_Extras is installed correctly, open any one of the host applications, access the VBE (either by pressing Alt + 
F11, or using the 'Visual Basic' button in the 'Developer' tab of the ribbon) and look for the 'Extras' menu item in the main menu 
across the top of the VBE window. If you can see 'Extras' and if you can use any of the menu items that it contains, then 
VBE_Extras has installed correctly. If not: 

• Firstly, if any of the Specific problems matches your situation then follow the advice there … if not 

• Secondly, follow each of the Troubleshooting steps (the order they are listed in is recommended but not essential) and 
check to see whether VBE_Extras loads following each one … 

 

Specific problems 
 

https://stackoverflow.com/help/minimal-reproducible-example


 
 

If you install or update VBE_Extras but VBE_Extras is not visible in the VBE (and the 'Extras' menu item is 

missing) 
 
Follow the Troubleshooting steps starting with Check the AddIn Manager. 
 

If you install or update VBE_Extras but, when opening the VBE, get an error message that "'VBE_Extras' 

could not be loaded." 
 
The install / update was not completed successfully, likely one or more registry keys was not updated correctly or a file is 
missing. 
 
To fix, you can either …  
 
Uninstall and re-install VBE_Extras: 

• Ensure you are the only user logged on to the device 

• Ensure all VBE-enabled applications are closed (including Excel, Access, Word, PowerPoint and Outlook) 

• Uninstall VBE_Extras – in Control Panel > Programs and Features (or you can select Settings > Apps) and uninstall 
VBE_Extras (all versions if multiple are present) … you can choose to not delete your settings if you want them to be 
available following re-installation 

• Go to the VBE_Extras downloads page https://www.thevbahelp.com/vbe-extras-download and download and re-install the 
latest version of VBE_Extras (see the Installation instructions if required) 

• If you still experience the problem, then re-boot your device and try again 
 
Or try an Admin install together with Check the Registry. 
 

If you update to a new version but still see an old version number in the 'About' dialog 
 
The update was not completed successfully, likely one or more registry keys was not updated correctly or a file is missing. To fix, 
carry out the same steps as for If you install or update VBE_Extras but, when opening the VBE, get an error message that 
"'VBE_Extras' could not be loaded.", above. 
 

If you need to install or check for .NET Framework 4.8 
 
The VBE_Extras installer will automatically check for .NET Framework 4.8 and inform you if it is not on your device. If the 
installer shows a dialog informing you that it is missing, then you will need to download it from the Microsoft website. 
 
From time-to-time, Microsoft changes the links to its websites but, at the time of writing, it can be downloaded from 
https://dotnet.microsoft.com/en-us/download/dotnet-framework/net48 (only the 'runtime' is required to run VBE_Extras, not 
the 'developer pack') … once downloaded, run the .exe file to install the .NET Framework 4.8. 
 
To check for yourself whether .NET Framework 4.8 is installed, you can either: 

• Download and run the .NET Framework 4.8 runtime installer from the link above … if you already have .NET Framework 4.8 
installed then you will see a dialog with the text ".NET Framework 4.8 or a later update is already installed on this 
computer" (or similar text) 

• Follow Microsoft's how-to guide (which will allow you to determine the exact version of the .NET Framework that is 
installed on your device, if any) at https://learn.microsoft.com/en-us/dotnet/framework/migration-guide/how-to-
determine-which-versions-are-installed#detect-net-framework-45-and-later-versions 

 
For further details on installation and .NET Framework in general, see https://docs.microsoft.com/en-
us/dotnet/framework/install/.  
 
 

If you receive an 'InvalidCastException' when starting the VBE 
 
This also may be shown as 'System.InvalidCastException'. 
 
There are two most likely causes of this: 

https://www.thevbahelp.com/vbe-extras-download
https://dotnet.microsoft.com/en-us/download/dotnet-framework/net48
https://learn.microsoft.com/en-us/dotnet/framework/migration-guide/how-to-determine-which-versions-are-installed#detect-net-framework-45-and-later-versions
https://learn.microsoft.com/en-us/dotnet/framework/migration-guide/how-to-determine-which-versions-are-installed#detect-net-framework-45-and-later-versions
https://docs.microsoft.com/en-us/dotnet/framework/install/
https://docs.microsoft.com/en-us/dotnet/framework/install/


 
 
 
1. VBE_Extras is 'clashing' with another VBE AddIn.  
 
In the VBE, select the Add-Ins > Add-In Manager menu option and untick the 'Loaded/Unloaded' and 'Load on startup' 
checkboxes for all AddIns (including for VBE_Extras) and OK to close the dialog. Then open the dialog again and tick the 
'Loaded/Unloaded' and 'Load on startup' checkboxes for VBE_Extras then OK to close the dialog. If VBE_Extras now loads 
correctly then it is 'clashing' with one or more other AddIn(s). If you have multiple other AddIns installed (ie as well as 
VBE_Extras) then likely the clash will be with only 1 of those other AddIns. You may want to experiment with ticking the 
'Loaded/Unloaded' and 'Load on startup' checkboxes for each other AddIn one at a time to identify which other AddIn 
VBE_Extras is clashing with. 
 
2. You have multiple versions of Office installed and have: mixed the bitness (all versions should be either 32 or 64 bit); or 

have installed in the wrong order (you should install the oldest version of Office first eg 2016 before 2019, before 2021 etc); 
or have installed Office 365 together with another version of Office and neither version is installed using MSI (Microsoft 
Software Installer, aka Windows Installer service) 

 
See https://support.microsoft.com/en-us/office/install-and-use-different-versions-of-office-on-the-same-pc-6ebb44ce-18a3-
43f9-a187-b78c513788bf for more info. The only fix for this, if you want to use VBE_Extras, is to uninstall and then re-install the 
Office versions following the guidance at the link. 
 

Troubleshooting steps 
 

Check the AddIn Manager 
 
In the VBE for any of the host applications, select the Add-Ins > Add-In Manager menu option and look for VBE_Extras in the 
'Available Add-Ins' list. If VBE_Extras is present, select it then ensure that 'Loaded/Unloaded' is checked and (if you want 
VBE_Extras to automatically load when the VBE is opened) that 'Load on Startup' is checked. OK to close the dialog. 
 
If you then get a message that "'VBE_Extras' could not be loaded" (or similar), do you have other VBE AddIns installed? Back in 
the AddIn Manager dialog, untick the 'Loaded/Unloaded' and 'Load on Startup' checkboxes for any other AddIns and OK to close 
the dialog. Then open the dialog again and tick the 'Loaded/Unloaded' and 'Load on Startup' checkboxes for VBE_Extras then OK 
to close the dialog. If VBE_Extras now loads correctly then it is 'clashing' with one or more other AddIn(s). If you have multiple 
other AddIns installed (i.e. as well as VBE_Extras) then likely the clash will be with only 1 of those other AddIns. You may want to 
experiment with ticking the 'Loaded/Unloaded' and 'Load on Startup' checkboxes for each other AddIn one at a time to identify 
which other AddIn VBE_Extras is clashing with. 
 

Re-boot your device 
 
I have seen instances where VBE_Extras (and other VBE AddIns, if any) have disappeared from the AddIn Manager dialog (see 
Check the AddIn Manager) and they have re-appeared following a re-boot of the device. 
 
Having re-booted your device, if VBE_Extras is not visible in the VBE then Check the AddIn Manager. 
 

Check disabled AddIns 
 
In the host application (not in the VBE), select File > Options > Add-ins. Next to Manage, select Disabled Items then click Go. If 
VBE_Extras is listed (or if mscoree.dll is listed), then select it then click 'Enable'. 
 
If you found a disabled AddIn, if VBE_Extras is not visible in the VBE then Check the AddIn Manager. 
 

Check the Registry 
 
NOTE THAT CHANGING VALUES IN THE REGISTRY CAN LEAVE YOUR DEVICE UNUSABLE … PROCEED WITH CAUTION AND AT 
YOUR OWN RISK.  
 
Following this step only makes sense if you have first followed the Check the AddIn Manager step and if VBE_Extras was not 
visible in the Add-In Manager or could not be loaded following using the Add-In Manager. 

https://support.microsoft.com/en-us/office/install-and-use-different-versions-of-office-on-the-same-pc-6ebb44ce-18a3-43f9-a187-b78c513788bf
https://support.microsoft.com/en-us/office/install-and-use-different-versions-of-office-on-the-same-pc-6ebb44ce-18a3-43f9-a187-b78c513788bf


 
 
 
Close all host applications (and any other applications you may have installed on your device that you know can use VBA). 
 
Open the Registry Editor (at the Windows 'Start' button, search for 'regedit', or at a command prompt, type 'regedit') and 
navigate to the following key depending on the bitness of your Microsoft Office installation: 
 
For 32-bit: HKEY_CURRENT_USER\SOFTWARE\Microsoft\VBA\VBE\6.0\Addins\VBE_Extras.Connect 
For 64-bit: HKEY_CURRENT_USER\SOFTWARE\Microsoft\VBA\VBE\6.0\Addins64\VBE_Extras.Connect 
 
Within the relevant key, you should see the following entries 
 
Entry  Type  Expected value 
(Default) REG_SZ  (value not set) 
Description REG_SZ  VBE Extras ... extending the VBA editor 
FriendlyName REG_SZ  VBE Extras 
LoadBehavior REG_DWORD 0x00000003 (3) 
 
If any of the entries are missing, you have the option to either manually add them and their values using the Registry Editor, or 
to uninstall / re-install VBE_Extras and re-installing will add the entries back to the Registry. 
 
If all of the entries are present, then note that only the value for LoadBehavior is critical. If it is not as expected, double-click on 
LoadBehavior. Enter '3' (without the quotes) as the 'Value data', press OK. 
 

Repair Office 
 
In Control Panel, select 'Programs and Features' (or in Settings, select 'Apps') then find the entry for Microsoft Office (may be 
listed as Microsoft 365 or a similar name), click Change (or Modify if you are in Settings) then either Quick Repair or Online 
Repair. 
 
If you do Quick Repair first and it does not help then subsequently try Online Repair. Note that an Online Repair can take a long 
time. 
 

Temporarily switch off your AntiVirus 
 
NOTE THAT SWITCHING OFF YOUR ANTI-VIRUS OBVIOUSLY CARRIES A RISK AND CAN POTENTIALLY EXPOSE YOUR DEVICE AND 
YOUR DATA TO VIRUSES AND OTHER MALWARE … PROCEED WITH CAUTION AND AT YOUR OWN RISK.  
 
I suggest you first disconnect from any network / internet before switching off your AV. Then close all host applications, then: 
1. Re-open one of the host applications, access the VBE and, if necessary, following the steps in Check the AddIn Manager … if 

no success, then 
2. With your AV still switched off, uninstall and then re-install VBE_Extras then follow step 1 
 
REMEMBER TO SWITCH YOUR ANTI-VIRUS BACK ON WHEN YOU HAVE COMPLETED THIS STEP! 
 

Speak to your IT support 
 
Especially if your device is managed by an IT support team, it is possible that Group Policy settings disables all AddIns and/or VBE 
AddIns. As a user, you will not be able to change the Group Policy settings. Speak to your IT support team. 
 

Contact me 
 
Before you do, please follow each of the above installation troubleshooting steps. They will resolve 99%+ of all problems - not 
following all of the steps wastes your time and mine! 
 
You can contact me using the email address on the website https://www.thevbahelp.com/vbe-extras-download, please let me 
know: 
1. The exact text of any error messages. 

https://www.thevbahelp.com/vbe-extras-download


 
 
2. The version of VBE_Extras you are trying to install (shown on the VBE_Extras download page and in the installation dialog 

while installing) – is always 4 numbers delimited by dots. 
3. Your version of Windows. 
4. The 'bitness' of Windows (32 bit or 64 bit). 
5. Your version of Office … or versions if you're running multiple versions of Office side-by-side. 
6. The 'bitness' of Office (32 bit or 64 bit) – note that this is distinct from the 'bitness' of Windows. 
7. The host application(s) you have tried to use VBE_Extras in. 
8. The 'Office display language' that you use … this is the language that is used in the ribbon, menu items, toolbars etc … it is 

typically set in: File > Options > Language > Office display language 
9. Does VBE_Extras appear in the AddIn Manager dialog (see Check the AddIn Manager)? What message, if any, do you get 

following ticking the 'Loaded/Unloaded' and 'Load on startup' checkboxes and clicking on OK? 
10. The names of any other AddIns installed in the VBE (see Check the AddIn Manager)? 
11. Whether this is a new / first installation of VBE_Extras or an update … if the latter, roughly how long have you had 

VBE_Extras installed on the same device for the same user? 
12. Attach a copy of the installation log file (the most recent, if multiple) … this will be in your 'Temp' folder (normally 

"C:\Users\%username%\AppData\Local\Temp") and called "Setup Log YYYY-MM-DD #NNN.txt" where YYYY-MM-DD is the 
date of the attempted installation and NNN is an iteration number starting from 001 

 
And, if possible: 
13. Whether any other users using the same device already have VBE_Extras installed? 
14. The version of the mscoree.dll file on your device … the full path to this file is "C:\Windows\System32\mscoree.dll" … right-

click on it then select Properties then Details … the File and Product version will likely be the same, if not, please advise both 
15. The name of the anti-virus software you use on your device (eg Microsoft Defender Antivirus or Norton AntiVirus Plus) 
16. Also helpful, but not essential, the message shown by the VBScript, below 
17. And again helpful, but not essential, is to know all versions of the .NET Framework you may have installed on your device … 

see https://docs.microsoft.com/en-us/dotnet/framework/migration-guide/how-to-determine-which-versions-are-installed  
18. Attach a copy of the VBE_Extras runtime log and exception file(s) … these will only be present on your device if you 

previously had a successful installation of VBE_Extras … these will be in the "C:\Users\%username%\AppData\Local " folder 
in sub-folder "VBE_Extras" … optionally Zip and provide the entire "VBE_Extras" folder 

 

VBScript 
 
Create a text file (i.e. a file with a .txt extension) on your Desktop or anywhere else convenient on your device. Add the following 
text: 
 
dim o 
set o = CreateObject("VBE_Extras.Connect") 
msgbox "OK" 

 
Save and close the text file. Change its extension from .txt to .vbs then double-click to run what is now a VBScript file. Make a 
note of what message, if any, you receive other than "OK" (the message, if any, will be shown in a dialog … you can press Ctrl+C 
to copy the entire text of the message while the dialog is showing). 
 

Admin install 
 
By default, VBE_Extras is installed per-user. If you need to install for all users on a device then you can try an admin install.  
 
First, locate the full path to the VBE_Extras.dll file which, if you have attempted a per-user install first, will be at 
"C:/Users/%username%/AppData/Local/Programs/VBE_Extras/VBE_Extras.dll" (where %username% is your username). 
 
Then confirm the 'bitness' of your Office installation (note this is not necessarily the same as the 'bitness' of Windows) … in any 
Office application, select File > Account > About <AppName> and towards the top of the resulting dialog will be details of the 
application including either 32-bit or 64-bit. 
 
Open an admin-level Command Prompt window (at the Windows start button, type "cmd" then select "Run as administrator"). 
In that Command Prompt window, run RegAsm (to register the assembly): 
 
For 32-bit Office, type (or copy/paste) the following (all on one line), replace the path, then press enter: 
 

https://docs.microsoft.com/en-us/dotnet/framework/migration-guide/how-to-determine-which-versions-are-installed


 
 
C:\Windows\Microsoft.NET\Framework\v4.0.30319\RegAsm.exe 
"C:/Users/%username%/AppData/Local/Programs/VBE_Extras/VBE_Extras.dll" /codebase 

 
For 64-bit Office, type (or copy/paste) the following (all on one line), replace the path, then press enter: 
 
C:\Windows\Microsoft.NET\Framework64\v4.0.30319\RegAsm.exe 
"C:/Users/%username%/AppData/Local/Programs/VBE_Extras/VBE_Extras.dll" /codebase 

 
If the resulting message: 

• Ends with "Types registered successfully" then the install was successful 

• Includes the text "Admin permissions are needed" then you only opened a 'normal' Command Prompt window … try again 
with an admin-level Command Prompt window 

• Includes the text "Unable to locate input assembly" then the path to the VBE_Extras.dll file was not correct … fix the path 
and try again 

 

Appendix 2 – why Shapes, Tables and Names? 
 
And why only in Excel? 
 
Simple answer, to save time. When I'm coding VBA, I find that I spend three quarters or more of my time doing it in Excel. And 
Shapes, Tables and Names can be awkward to find … especially if you have a Workbook with many Worksheets each of which 
has many Shapes, Tables and/or Names. Being able to jump instantly to the relevant object in the user-interface or to jump 
instantly from the user-interface into the code that refers to the object saves a huge amount of time. And that's why I wrote 
VBE_Extras … to save time. 
 
Why not other objects in the user-interface? Worksheets and Charts sheets would be obvious … but they're easy to find. Ranges 
/ cells are also obvious but (thinking about Worksheets), every Worksheet has the same references … which Worksheet to jump 
to for eg Range "A1" … and then what about Cells(1, 1) … too much work to code, too little benefit. They're easy to find. No time 
saved. 
 
And what about all of the other vast array of objects that can be added to the Excel user-interface … Charts, PivotTables etc etc 
etc. Well, I could add the same functionality, but I tend to find that there will only ever be a small number of each of these in any 
one Workbook, so they tend to be easy to find … so no time saved. 
 

Appendix 3 – Update history 
 
This table only reflects the versions since 1.0.0.0. Every release includes some level of bug fixes and minor 'tweaks' … that fact is 
not repeated in the 'notable changes' for every release. 
 

Date Version Notable changes 

1st Jul 24 1.5.1.0 • 'Add a "GetEnumAsString()" function' 

24th Jun 24 1.5.0.0 • Can now parse Type Libraries – 'Show All Members', 'Info for code at cursor', 'Qualify 
reference' and 'AutoText' (for Select…Case) updated 

• Type Library explorer 

• Add Enum from Type Library 

• Special binding 

16th May 24 1.4.8.0 • Update "Project References" 

• Version Control / Compare Project – option to ignore line numbers 

3rd May 24 1.4.7.1 • Licensing changes 

22nd Apr 24 1.4.7.0 • Version Control – Project references are imported 

• Version Control – RibbonX is exported, warn on import 

• Extended Highlight functionality 

• View RibbonX 

8th Apr 24 1.4.6.0 • Line numbers – add/update and remove 

• Version Control – Project references are exported, warn on import 



 
 

• Compare Project 

• Orphans functions check for read and write, where appropriate (experimental) 

• Change the main menu accelerator key 

17th Mar 24 1.4.5.1 • Version Control – updated 'diff report' 

• Compare Module 

29th Feb 24 1.4.5.0 • Split line(s) 

• Call hierarchy 

• List all procedure / property / variable / constant Attributes in a Module 

• Clean Project 

• Conditional compilation directives … enhancements to expression intrepretation 

• Backup ... improved 

• Live Code Info … removed 

27th Jan 24 1.4.4.0 • Version Control 

• Indent for whole Project 

26th Nov 23 1.4.3.0 • Indent procedure / Module 

14th Nov 23 1.4.2.0 • Expanded 'AutoText' 

26th Oct 23 1.4.1.4 • Bug fixes only 

23rd Oct 23 1.4.1.3 • Bug fixes only 

4th Oct 23 1.4.1.2 • Orphan-checking of Modules is now all Modules, not just standard Modules 

29th Aug 23 1.4.1.1 • Bug fixes only 

7th Aug 23 1.4.1.0 • Sub to 'Run Again' 

• 'Sub to run' enhancements 

• Comment / Uncomment 

• Project Picker 

22nd Jun 23 1.4.0.1 • Keyboard shortcuts applied 'statically' are now treated as references (Excel only) 

• Setting to allow/block automatic checks for updated versions of VBE_Extras 

12th Jun 23 1.4.0.0 • Multi-Project … handles references to / from other VBA Projects (including indirect references) 

20th Apr 23 1.3.1.0 • Implement Interface / Extract Interface 

• DefType statements handled 

• Extract literal value to Const now allows 'case sensitive' when working with Strings 

• When showing a list of references, indicate whether the reference is getting or letting/setting 
(experimental) 

7th Apr 23 1.3.0.0 • Live Code Info 

• Make 'Option Explicit' (experimental) 

• New search methodology (experimental) 

• Major performance improvements when identifying declarations and references 

23rd Mar 23 1.2.0.1 • Save / load / reset Settings 

• Performance improvements when identifying declarations and references 

10th Mar 23 1.2.0.0 • Now works in Access 

• Go to implementation / go to base (for interfaces) 

• Option to visually distinguish Class Modules that have VB_PredeclaredId = True vs False 

• Expanded Toolbar 

• Performance improvements when identifying declarations and references 

21st Feb 23 1.1.6.2 • View 'Previous Lists' 

15th Feb 23 1.1.6.1 • Improved handling for bang operator ("!") 

• View references being renamed from the 'Rename' dialog 

• When viewing references on a line with continuations, see full (continued) line in a tool-tip 

• More progress bars for potentially long-running operations 

10th Jan 23 1.1.6.0 • Extract literal value to Const 

• Focus mode 

• Highlight - draw a box over the text 

• Show hidden members (auto or via menu) 

17th Nov 22 1.1.5.0 • Tables – go to Shape / usages (Excel only) 

• Names – go to Shape / usages (Excel only) 

• Tables, Names and Shapes – works across AddIn and active Workbook 

• List all matches of a literal value 



 
 

4th Nov 22 1.1.4.1 • Mouse-click navigation / actions 

• Option to disable Module Picker 

25th Oct 22 1.1.4.0 • Installation does not require admin privileges 

• Themes 

20th Sep 22 1.1.3.1 • Bug fixes only 

13th Sep 22 1.1.3.0 • Shapes – go to Shape / usages / OnAction (Excel only, single Workbook only) 

• Orphans - optionally ignore RibbonX callbacks and procedures 'called by String' 

• Tasks – more priorities 

• Tidied up menus 

• The 'Option Explicit' dialog has an option to defer subsequent appearance of itself 

19th Aug 22 1.1.2.1 • Go to declaration above / below 

• Performance improvements when getting references 

9th Aug 22 1.1.2.0 • Bug fixes only 

8th Aug 22 1.1.1.0 • Move line(s) up / down 

• Replace All Modules (experimental) 

27th Jul 22 1.1.0.0 • Auto add Property 

• Auto add Factory 

• Qualify reference 

• CSV export from orphans dialog 

18th Jul 22 1.0.0.0 • Version 1 release 

 

Appendix 4 – changing the main menu's 'x' accelerator key 
 
The default accelerator key / letter used to trigger the main menu is 'x' (e.g. if you press and release the Tab key and then press 
and release the 'x' key, the VBE will activate the VBE_Extras main menu). If 'x' does not work for you (some non-English 
languages have other menu items that already use the 'x' key or you may use other Add-Ins that also uses the 'x' key) then you 
can change it in the ‘App’ tab in VBE_Extras’ Settings dialog, select the ‘Menu accelerator key’ button and in the drop-down 
select the key/letter that you want to use in place of 'x' (or no accelerator key/letter). 
 
 


